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1

Wprowadzenie

Dziękujemy za wybór firmy Medtronic Diabetes na swojego partnera w kontroli leczenia cukrzycy

u pacjentów. Jesteśmy przekonani, że najnowocześniejsza technologia i prosty  w obsłudze

interfejs użytkownika oprogramowania CareLink® Pro przyniosą Państwu wiele korzyści.

Oprogramowanie CareLink Pro umożliwia pobieranie i przechowywanie danych diagnostycznych

i dotyczących leczenia oraz tworzenie raportów na ich podstawie. Można go również używać do

uzyskiwania dostępu do pompy, glukometru oraz danych o stężeniach glukozy zarejestrowanych

przez sensor i przesłanych przez pacjentów do opartego na technologii sieciowej systemu

kontroli leczenia CareLink® Personal współpracującego z oprogramowaniem CareLink Pro.

Funkcje

CareLink Pro jest oprogramowaniem do kontroli leczenia cukrzycy instalowanym na komputerze

osobistym. Zawiera następujące funkcje:

• Możliwe jest tworzenie rekordów pacjenta w celu przechowywania danych pobranych z

urządzenia pacjenta oraz danych dotyczących terapii z konta CareLink Personal pacjenta.

• Dane pochodzące z pomp insulinowych, monitorów i glukometrów mogą być wysyłane do

systemu, przechowywane, a następnie wykorzystywane do tworzenia raportów.

• Możliwe jest również opcjonalne połączenie z systemem CareLink Personal, co umożliwia

dostęp do przechowywanych przez pacjentów danych z urządzenia. Najlepiej jest tworzyć

aktualne raporty pomiędzy wizytami u lekarza, dzięki czemu w trakcie kolejnych wizyt odczyt

danych z urządzenia nie będzie konieczny.

• Z danych z urządzenia przechowywanych w rekordzie pacjenta można utworzyć różne

raporty dotyczące terapii. Dzięki raportom znalezienie odpowiedzi na wątpliwości dotyczące

terapii związane z zachowaniem pacjenta, schematami terapii i zastrzeżeniami jest

łatwiejsze.

• System zawiadamia o dostępnych aktualizacjach oprogramowania, które mogą zostać

pobrane i zainstalowane, co zapewnia dostęp do najnowszych funkcji.
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• Funkcja Guide Me (Prowadź mnie) stanowi wsparcie dla nowych użytkowników

oprogramowania CareLink Pro. Dostarcza ona wskazówek i porad dotyczących

wykonywanych zadań.

• Zintegrowany system pomocy wchodzi w skład oprogramowania, zapewniając informacje

dotyczące konkretnych obszarów zainteresowań.

Bezpieczeństwo

• Oprogramowanie CareLink Pro może być chronione hasłem.

• Transmisja danych pacjenta z systemu CareLink Personal jest szyfrowana przy użyciu zgodnej

ze standardami branży informatycznej technologii Secure Sockets Layer (SSL).

Dokumenty towarzyszące

Każdy z następujących dokumentów firmy Medtronic MiniMed zawiera informacje dotyczące

danego urządzenia, które nie są przedstawione szczegółowo w niniejszym podręczniku

użytkownika.

UWAGA: Właściwe dla danego urządzenia informacje dotyczące glukometrów znajdują się w

instrukcji producenta dołączonej do glukometru.

• Podręcznik użytkownika pompy insulinowej Paradigm

• Podręcznik użytkownika monitora Guardian REAL-Time

• Podręcznik użytkownika opisujący funkcje sensora

• Podręcznik użytkownika urządzenia ComLink

• Podręcznik użytkownika urządzenia CareLink USB

Pomoc

Jeśli konieczna jest dodatkowa pomoc dotycząca tego systemu, należy się skontaktować z

lokalnym przedstawicielem firmy. Międzynarodowe informacje kontaktowe można znaleźć pod

adresem:

http://www.minimed.com/contact/international-locations

Obsługiwane urządzenia

Oprogramowanie CareLink Pro pobiera dane z następujących urządzeń.

UWAGA: Niektóre urządzenia obsługiwane przez niniejsze oprogramowanie mogą nie być
dostępne we wszystkich krajach, w których zostało ono zatwierdzone do użytku.
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Pompy insulinowe/monitory stężenia glukozy

Pompy Medtronic MiniMed: 508

Pompy z serii Medtronic MiniMed Paradigm®: 511, 512, 712, 515, 715, 522, 722, 522K, 722K,
Paradigm® Veo™ (554, 754)

Monitory Guardian REAL-Time:
CSS-7100

CSS-7100K

Producent Glukometry

Podłączone glukometry:
• Bayer CONTOUR® LINK

• Monitor stężenia glukozy we krwi BD Paradigm
Link®

Bayer:

• CONTOUR® USB

• Ascensia BREEZE®

• BREEZE® 2

• CONTOUR®

LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2

• OneTouch® UltraMini®

• OneTouch® UltraEasy®

BD: • Logic®

Rodzina produktów Bayer Ascensia™ DEX™, w tym
następujące zgodne glukometry:

• Ascensia™ DEX™

• Ascensia™ DEX™ 2

• Ascensia™ DEXTER-Z® II

• Glucometer™ DEXTER-Z®

• Ascensia™ ESPRIT® 2

• Glucometer™ ESPRIT®

• Glucometer™ ESPRIT® 2

Rodzina produktów Bayer Ascensia™ ELITE™, w tym
następujące zgodne glukometry:

• Ascensia™ ELITE™

• Glucometer™ ELITE™ XL
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Producent Glukometry

Abbott:

• FreeStyle®

• FreeStyle® Lite®

• FreeStyle® Freedom®

• FreeStyle® Freedom Lite®

• Precision Xtra®

• TheraSense FreeStyle®

• FreeStyle® Flash®

• FreeStyle® Papillon™ mini

• FreeStyle® Mini®

• Optium Xceed™

• Precision Xceed™

Roche:

• Accu-Chek® Aviva

• Accu-Chek® CompactPlus

• Accu-Chek® Compact

• Accu-Chek® Active

Urządzenia komunikacyjne

CareLink® USB Do użytku z pompą insulinową z serii MiniMed
Paradigm i monitorem Guardian REAL-Time.

Monitor stężenia glukozy we krwi Paradigm Link®

Do użytku z pompą MiniMed Paradigm lub monitorem
Guardian REAL-Time. (Szczegółowe informacje na
temat wymaganego sprzętu można znaleźć w
podręczniku użytkownika monitora stężenia glukozy
we krwi Paradigm Link®).

Urządzenie ComLink

Do użytku z pompą MiniMed Paradigm i monitorem
Guardian REAL-Time. (Szczegółowe informacje na
temat wymaganego sprzętu można znaleźć w
podręczniku użytkownika urządzenia ComLink).

Urządzenie Com-Station

Do użytku z pompą Medtronic MiniMed 508.
(Szczegółowe informacje na temat wymaganego
sprzętu można znaleźć w podręczniku użytkownika
urządzenia Com-Station).

Kabel do transmisji danych

Do użytku z glukometrami innych firm. Kabel do
transmisji danych jest dostarczany przez wszystkich
producentów glukometrów.

Uwaga: Jeśli producent glukometru dołącza kabel USB
zamiast kabla szeregowego w celu przesyłania danych,
należy zainstalować sterownik oprogramowania
dostarczony przez tego producenta.

Ponadto należy skontaktować się z producentem
glukometru, aby upewnić się, że sterownik USB jest
zgodny z używanym systemem operacyjnym. Niektóre
sterowniki USB mogą nie być dostępne w przypadku
64-bitowych systemów operacyjnych.

Odpowiedniki

Przy dodawaniu urządzenia do systemu należy wybrać jego markę oraz model z listy. Jeśli

marka i model nie znajdują się na liście, należy znaleźć odpowiednik w poniższej tabeli.

CareLink Pro Podręcznik użytkownika   Wprowadzenie 4



Urządzenie używane przez pacjenta Odpowiednik

• Bayer Ascensia™ DEX™ 2

• Bayer Ascensia™ DEXTER-Z™ II

• Bayer Glucometer™ DEXTER-Z™

• Bayer Ascensia™ ESPRIT® 2

• Bayer Glucometer™ ESPRIT®

• Bayer Glucometer™ ESPRIT® 2

Bayer Ascensia™ DEX™

Bayer Glucometer™ ELITE™ XL Bayer Ascensia™ ELITE™

Precision Xceed™ Optium Xceed™

Zamawianie

Aby zamówić produkty firmy Medtronic Diabetes, należy skontaktować się z jej lokalnym

przedstawicielem. Międzynarodowe informacje kontaktowe można uzyskać pod poniższym

adresem URL:

http://www.medtronicdiabetes.com/help/contact/locations.html

UWAGA: Glukometry mogą być zamawiane od ich producentów.

Sposób korzystania z podręcznika

UWAGA: W podręczniku użytkownika przedstawiono przykładowe kopie ekranów

oprogramowania. Rzeczywisty wygląd wyświetlanych ekranów oprogramowania może się
nieznacznie różnić od przedstawionych w podręczniku.

Definicje terminów i funkcji zawarto w słowniku. W poniższej tabeli przedstawiono konwencje

stosowane w tym podręczniku.

Termin/format Znaczenie

Nacisnąć Nacisnąć lewy przycisk myszy, aby wybrać dany obiekt
na ekranie.

Nacisnąć dwukrotnie Nacisnąć dwukrotnie lewy przycisk myszy, aby
otworzyć wybrany obiekt na ekranie.

Nacisnąć prawym przyciskiem myszy Nacisnąć prawym przyciskiem myszy wybrany obiekt
na ekranie, aby wyświetlić inne okno lub menu.

Tekst pogrubiony
Używany dla przycisków, nazw ekranów, nazw pól lub
opcji menu. Na przykład: Patient > New Patient
(Pacjent > Nowy pacjent).

UWAGA: 
Zawiera dodatkowe informacje na temat procedury
lub czynności.
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Termin/format Znaczenie

PRZESTROGA:
Ostrzega o potencjalnym zagrożeniu, które, jeśli nie
zostanie zażegnane, może spowodować niewielkie lub
umiarkowane uszkodzenia oprogramowania lub
sprzętu.

OSTRZEŻENIE:

Informuje o potencjalnym niebezpieczeństwie, które,
jeśli nie zostanie zażegnane, może spowodować
śmierć lub poważne obrażenia. Może również
opisywać potencjalne poważne reakcje niepożądane i
zagrożenia.

Bezpieczeństwo użytkownika

Wskazania

System CareLink Pro jest przeznaczony do użycia jako narzędzie pomocne w kontroli leczenia

cukrzycy. System umożliwia pobieranie informacji przesyłanych z pomp insulinowych,

glukometrów oraz systemów ciągłego monitorowania stężenia glukozy i sporządzanie na ich

podstawie raportów programu CareLink Pro. Raporty dostarczają informacji przydatnych w

identyfikacji trendów i śledzeniu dziennych aktywności, takich jak spożycie węglowodanów, czas

posiłków, podawanie insuliny oraz odczyty stężenia glukozy.

Ostrzeżenia

• System jest przeznaczony do użycia przez lekarza specjalistę z praktyką w zakresie kontroli

leczenia cukrzycy.

• Wyniki uzyskiwane przez system nie udostępniają żadnych informacji o charakterze porady

lekarskiej i nie mogą być traktowane jako źródło takich informacji.

• Niniejszy produkt powinien być używany wyłącznie z obsługiwanymi urządzeniami

wymienionymi w niniejszym podręczniku. (Patrz Obsługiwane urządzenia na stronie 2).

• Należy zalecić pacjentom sprawdzanie poziomu glukozy we krwi co najmniej 4–6 razy

dziennie.

• Pacjenci nie powinni wprowadzać żadnych zmian w leczeniu bez konsultacji z lekarzem

specjalistą.

• Decyzje o leczeniu pacjenci powinni podejmować w oparciu o wskazówki lekarza oraz wyniki

stężenia glukozy zmierzone glukometrem, a nie przy użyciu sensora glukozy.
 
Przeciwwskazania

Oprogramowania nie należy używać z urządzeniami innymi niż wymienione w części Obsługiwane

urządzenia na stronie 2.  Ponadto nie należy używać tego produktu w terapii schorzeń innych niż

cukrzyca.

Przed otwarciem oprogramowania należy zamknąć następujące programy, jeśli są aktualnie

uruchomione na komputerze:

• Oprogramowanie CGMS® System Solutions™ (7310)

• Oprogramowanie pomp i glukometrów Solutions® (7311)

• Oprogramowanie Guardian® Solutions® (7315)
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• ParadigmPAL™ (7330)

• Oprogramowanie CareLink® Personal (7333)

• Oprogramowanie Solutions® do systemu CGMS®iPro (7319)
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2

Początek pracy

Poniższe informacje dotyczą uruchamiania oprogramowania CareLink Pro, otwierania i zamykania

rekordów pacjenta oraz ustawiania preferencji odnoszących się do wszystkich pacjentów w

systemie.

Przed rozpoczęciem

Jeżeli użytkownik używa oprogramowania CareLink Pro po raz pierwszy, powinien się upewnić, że

ustawione są preferencje na karcie General (Ogólne) (patrz Preferencje ogólne na stronie 13).

Preferencje te określają sposób wyświetlania pewnych elementów w oprogramowaniu i w

raportach, a także sposób komunikacji systemu z Internetem.

Preferencje można ustawić w dowolnej chwili. Warto rozważyć odłożenie ustawienia innych

preferencji do czasu zaznajomienia się z oprogramowaniem CareLink Pro.

Główne zadania systemu

W poniższej tabeli opisano pokrótce główne zadania, których wykonanie może być pożądane

podczas wstępnej konfiguracji i pierwszego użycia oprogramowania CareLink Pro. Znajdują się w

niej również informacje na temat części niniejszego podręcznika użytkownika, w których opisano

poszczególne zadania.

Krok Lokalizacja

Zapoznanie się z interfejsem użytkownika
oprogramowania CareLink Pro. Nawigacja w systemie na stronie 9

Zdefiniowanie opcji systemu, które będą
wykorzystywane globalnie w danym zakładzie opieki
zdrowotnej.

Ustawianie preferencji systemowych na stronie 12

Utworzenie profilów wszystkich pacjentów. Dodawanie nowych profilów na stronie 21

Utworzenie połączeń z kontami pacjentów w
programie CareLink Personal.

Tworzenie połączeń z kontami programu CareLink
Personal na stronie 22

Dodanie pompy i glukometrów pacjenta do jego
osobistego profilu. Dodawanie urządzenia na stronie 29

CareLink Pro Podręcznik użytkownika   Początek pracy 8



Krok Lokalizacja

Odczyt danych z pompy i glukometrów pacjenta. Odczytywanie danych z urządzenia na stronie 35

Konfiguracja i tworzenie raportów dla poszczególnych
pacjentów. Tworzenie raportów na stronie 38

Regularne tworzenie kopii zapasowych bazy danych
systemu CareLink Pro. Tworzenie kopii zapasowej bazy danych na stronie 50

Aktualizowanie oprogramowania CareLink Pro. Stosowanie aktualizacji oprogramowania na stronie 48

Nawigacja w systemie

Przed rozpoczęciem pracy z oprogramowaniem CareLink Pro należy zapoznać się z interfejsem

użytkownika. W jego skład wchodzą ekrany menu, paski narzędzi i nawigacji, obszary robocze i

okno Guide Me (Prowadź mnie).

Otwieranie programu CareLink Pro

1 Nacisnąć dwukrotnie ikonę CareLink Pro  na pulpicie komputera lub wybrać program

Medtronic CareLink Pro  z listy programów w menu Start systemu Windows.

Jeśli w klinice wymagane jest wprowadzanie hasła, wyświetlany jest ekran rejestracyjny.

a. Wpisać hasło w polu Password  (Hasło).

UWAGA: Funkcję rejestracji przy użyciu hasła można ustawić opcjonalnie podczas
procesu instalacji.

b. Nacisnąć przycisk LOGIN (Rejestruj).

Wyświetlony zostaje ekran rozpoczynania.

2 Aby utworzyć nowy rekord pacjenta, należy nacisnąć przycisk New Patient  (Nowy pacjent).

Aby otworzyć rekord pacjenta z listy pacjentów w systemie, nacisnąć przycisk Open Patient

(Otwórz rekord pacjenta).

Obszary robocze

Jeśli rekord pacjenta jest otwarty, można nacisnąć jeden z przycisków na pasku nawigacyjnym,

aby wyświetlić odpowiedni obszar roboczy. Z obszarów roboczych należy korzystać w celu

wprowadzania lub wyboru informacji potrzebnych do realizacji zadań w oprogramowaniu

CareLink Pro dotyczących danego pacjenta.

Profile (Profil): umożliwia przechowywanie informacji
o pacjencie, takich jak imię i nazwisko czy data
urodzenia. Z tego obszaru roboczego można również
połączyć się z kontem pacjenta w programie CareLink
Personal.

Devices (Urządzenia): pozwala na przechowywanie
informacji koniecznych do odczytu danych z
urządzenia pacjenta.

Reports (Raporty): umożliwia wybór parametrów i
raportów, które są tworzone dla pacjenta.
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Do momentu dodania i zapisania profilu pacjenta dostępny jest wyłącznie obszar roboczy Profile

(Profil). Do czasu dodania urządzeń pacjenta ma on dostęp jedynie do obszarów roboczych

Profile (Profil) oraz Devices (Urządzenia).

Pasek narzędzi

Pasek narzędzi programu CareLink Pro umożliwia szybki dostęp do często używanych funkcji. Na

pasku narzędzi wyświetlane są następujące przyciski.

Przycisk Nazwa Funkcja

Add Patient (Dodaj pacjenta)

Otwiera obszar roboczy Profile
(Profil), umożliwiając dodawanie
nowego rekordu pacjenta do
systemu.

Open Patient (Otwórz rekord
pacjenta)

Otwiera tabelę Patient Lookup
(Wyszukiwanie pacjenta), w której
można wybrać istniejący rekord
pacjenta do wyświetlenia.

Guide Me (Prowadź mnie)

Wyświetla lub ukrywa okno Guide
Me (Prowadź mnie). Nacisnąć, aby
uzyskać dostosowane do kontekstu
wskazówki systemu.

Zakładki pacjentów

Po otwarciu rekordu pacjenta wzdłuż paska narzędzi wyświetlana jest zakładka z imieniem i

nazwiskiem pacjenta. Aktywna zakładka oznacza, że rekord pacjenta i obszar roboczy są aktywne

oraz możliwe jest przeprowadzanie zadań oprogramowania CareLink Pro dotyczących pacjenta.

W celu uaktywnienia rekordu pacjenta, aby można było z nim pracować, należy nacisnąć zakładkę

tego pacjenta. Aby zamknąć rekord pacjenta, należy nacisnąć przycisk Close (Zamknij)  na

zakładce.

Funkcja Guide Me (Prowadź mnie)

Funkcja Guide Me (Prowadź mnie) jest dostępna w całym programie CareLink Pro. Jej wybór

powoduje otworzenie dostosowanych do kontekstu wskazówek i porad dotyczących działań,

które mogą zostać podjęte w aktywnej części systemu. Okna Guide Me (Prowadź mnie) mogą

również zawierać łącza >> learn more  (dowiedz się więcej). Po ich naciśnięciu otwiera się
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odpowiednia sekcja pomocy online ze szczegółowymi informacjami na dany temat. Funkcja

Guide Me (Prowadź mnie) jest domyślnie włączona. Można ją jednak wyłączyć w dowolnym

momencie.

Włączanie i wyłączanie funkcji Guide Me (Prowadź mnie)

Aby włączyć lub wyłączyć funkcję Guide Me (Prowadź mnie), należy wykonać jedną z

następujących czynności:

• Nacisnąć przycisk Guide Me  (Prowadź mnie). 

• Wybrać kolejno opcje Help  > Guide Me  (Pomoc > Prowadź mnie).

Otwieranie rekordów pacjenta

Jednorazowo można otworzyć maksymalnie sześć rekordów pacjenta. Jeżeli  nie zostały jeszcze

utworzone żadne profile pacjentów, patrz Dodawanie nowych profilów na stronie 21.

1 Wybrać kolejno opcje File > Open Patient  (Plik > Otwórz rekord pacjenta) lub nacisnąć

przycisk Open Patient  (Otwórz rekord pacjenta).  Zostanie wyświetlona lista pacjentów

podobna do przedstawionej poniżej.
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UWAGA: W przypadku wyświetlenia komunikatu o zbyt dużej liczbie otwartych
rekordów pacjenta należy nacisnąć przycisk OK, zamknąć rekord i kontynuować.

2 Znaleźć pacjenta na liście przez wpisanie imienia lub nazwiska pacjenta w polu Find a
Patient  (Znajdź pacjenta). Gdy pacjent zostanie podświetlony na liście, nacisnąć przycisk

OPEN (Otwórz), a następnie dwukrotnie nacisnąć pozycję na liście lub przycisk ENTER. Po

liście można poruszać się również za pomocą strzałek w górę i w dół na klawiaturze.

Wyświetlany jest obszar roboczy Devices (Urządzenia) (jeżeli urządzenia nie zostały jeszcze

dodane) lub Reports  (Raporty) pacjenta.

3 Aby obejrzeć obszar roboczy Profile  (Profil) pacjenta, nacisnąć przycisk Profile  (Profil) 

na pasku nawigacyjnym.

Zamykanie rekordów pacjenta

1 Upewnić się, że rekord pacjenta, który ma zostać zamknięty, jest aktywny (zakładka jest

podświetlona).

2 Wykonać jedną z poniższych czynności:

a. Wybrać kolejno opcje File > Close Patient (Plik > Zamknij rekord pacjenta).

b. Nacisnąć przycisk Close  (Zamknij)  na zakładce pacjenta.

c. Nacisnąć klawisze Ctrl+F4.

Ustawianie preferencji systemowych

Te preferencje odnoszą się do wszystkich pacjentów w systemie. Aby dowiedzieć się więcej na

temat preferencji odnoszących się do poszczególnych pacjentów, patrz Sprawdzanie ustawień

raportów na stronie 41.

Preferencje są wyświetlane w następujących grupach:

• General (Ogólne)

- Glucose units (Jednostki stężenia glukozy)

- Carbohydrate units (Jednostki węglowodanowe)

- Communications (Komunikacja)

- Troubleshooting (Rozwiązywanie problemów)

• Patient Profile (Profil pacjenta)

- Można tu wybrać i ułożyć pola danych w profilach pacjenta.

• Patient Lookup (Wyszukiwanie pacjenta)

- Służy do modyfikacji i zmiany kolejności wyświetlania pól po wybraniu opcji Open

Patient (Otwórz rekord pacjenta) w celu obejrzenia listy pacjentów.

• Report Generation (Tworzenie raportu)

- Można tu wybrać pola danych, które mają być wyświetlane po wybraniu wypełnienia

raportu Daily Detail (Szczegóły z dnia) z tabeli danych.

CareLink Pro Podręcznik użytkownika   Początek pracy 12



Preferencje ogólne

Korzystając z zakładki General (Ogólne), można definiować sposób wyświetlania pewnych

typów informacji przez oprogramowanie i określać preferencje dotyczące komunikacji

zewnętrznej.

1 Jeśli nie jest ona jeszcze aktywna, nacisnąć zakładkę General  (Ogólne).

2 Wybrać kolejno opcje Tools > Options (Narzędzia > Opcje). Wyświetlone zostanie

następujące okno.

3 Nacisnąć przycisk opcji pożądanej wartości:

- Glucose Units  (Jednostki stężenia glukozy): mg/dl lub mmol/l

- Carbohydrate Units  (Jednostki węglowodanowe): grams (gramy) lub Exchanges

(Wymienniki)

a. W przypadku wybrania przycisku Exchanges (Wymienniki) dla opcji Carbohydrate Units
(Jednostki węglowodanowe) należy wpisać odpowiednią liczbę w polu grams are equal
to 1 Exchange  (gramów równa się 1 wymiennikowi).

4 Nacisnąć pole wyboru w sekcji Chart Options (Opcje wykresu) > Overview Report (Informacje

ogólne), aby je zaznaczyć lub odznaczyć. Jeśli pole wyboru jest zaznaczone, aplikacja połączy

odczyty stężenia glukozy na wykresie Meter Glucose Overlay (Nałożenie pomiarów stężenia

glukozy z glukometru) za pomocą linii. Jest to wykres wyświetlany w raporcie Sensor and

Meter Overview (Informacje ogólne na temat sensora i glukometru).

5 W przypadku poniższych preferencji z sekcji Communications (Komunikacja) należy

zaznaczyć (włączyć) lub odznaczyć (wyłączyć) odpowiednie pole wyboru:

UWAGA: Podczas ustawiania preferencji dotyczących komunikacji należy postępować
zgodnie z wytycznymi kliniki lub działu informatycznego.
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- Automatically check for software updates (Automatycznie wyszukuj aktualizacje
oprogramowania): jeżeli to pole jest zaznaczone, do każdego działającego systemu z

oprogramowaniem CareLink Pro zostanie wysłane powiadomienie, gdy dostępna będzie

aktualizacja oprogramowania. Aktywny użytkownik będzie miał wówczas możliwość

pobrania i zainstalowania aktualizacji. Aby tak się nie działo, a aktualizacje

oprogramowania były rozprowadzane w sposób kontrolowany, można odznaczyć to pole

wyboru.

- Synchronize with Medtronic CareLink® Personal (Synchronizuj z Medtronic
CareLink Personal):  jeżeli system ma dokonywać automatycznej synchronizacji z

danymi pacjenta w programie CareLink Personal za każdym razem, gdy otwierany jest

profil danego pacjenta, należy zaznaczyć to pole wyboru. Jeżeli to pole wyboru zostanie

odznaczone, dla każdego pacjenta będzie wymagana ręczna synchronizacja z danymi z

programu CareLink Personal.

6 Nacisnąć pole wyboru w sekcji Troubleshooting (Rozwiązywanie problemów), aby je

zaznaczyć lub odznaczyć. Jeżeli to pole wyboru jest zaznaczone, aplikacja zapisze odczyty

urządzenia w celu rozwiązywania problemów.

7 Nacisnąć przycisk OK w celu zapisania preferencji na karcie General (Ogólne).

Preferencje profilów pacjenta

Jest to globalne ustawienie definiujące zawartość profilów. Można dostosowywać pola w

obszarze roboczym Profiles (Profile) w taki sposób, aby przedstawiane były informacje

najważniejsze w danym zakładzie opieki zdrowotnej. Można dodawać i usuwać pola, tworzyć

własne pola niestandardowe oraz określać kolejność wyświetlania pól w oknie.

1 Wybrać kolejno opcje Tools > Options (Narzędzia > Opcje).

2 Nacisnąć zakładkę Patient Profile  (Profil pacjenta). Wyświetlone zostanie następujące

okno.
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UWAGA: Za pomocą pól wyboru wybrać pola, które mają występować w profilu. Za
pomocą strzałek w górę i w dół ustawić pola w odpowiedniej kolejności.

Wybieranie pól danych

1 Za pomocą pól wyboru dodać żądane pola.

UWAGA: Nie można usunąć pól First Name (Imię) i Last Name (Nazwisko).

2 Aby usunąć pole z profilu, należy odznaczyć jego pole wyboru.

3 Aby uczynić pole wymaganym, należy zaznaczyć pole wyboru w kolumnie Required
(Wymagane). Pole wymagane musi zostać wypełnione przed utworzeniem profilu.

Dodawanie pola niestandardowego

1 Zaznaczyć pole wyboru na lewo od pustego pola niestandardowego.

2 Wprowadzić tekst w celu nazwania pola (np. Kontakt w nagłym wypadku). Ta nazwa pola

będzie wyświetlana w profilu pacjenta.

3 Aby uczynić pole wymaganym, należy zaznaczyć pole wyboru w kolumnie Required
(Wymagane).

UWAGA: Aby usunąć pole niestandardowe z profilu, należy odznaczyć pole wyboru obok
pola (pól), które ma zostać usunięte.

Zmiana kolejności pól danych

Wybrać pole, które ma zostać przesunięte, a następnie nacisnąć strzałkę w górę lub w dół  w

celu przesunięcia pola. (Strzałki na górze i na dole przesuwają pole na samą górę lub na sam dół

listy).

Kończenie ustawiania preferencji profilu pacjenta

Gdy na liście Field Order (Kolejność pól) występują wszystkie pożądane pola w odpowiedniej

kolejności, nacisnąć przycisk OK.

Profile pacjenta zawierają teraz właśnie wybrane pola w odpowiedniej kolejności.

Preferencje na karcie Patient Lookup (Wyszukiwanie pacjenta)

Tabela Patient Lookup (Wyszukiwanie pacjenta) służy do wyszukiwania i otwierania rekordów

pacjenta. Tabela obejmuje każdego pacjenta w bazie danych i zawiera informacje

identyfikacyjne z profilu pacjenta. Istnieje możliwość dostosowywania informacji wyświetlanych

w tej tabeli oraz kolejności kolumn. Aby dostosować tabelę Patient Lookup (Wyszukiwanie

pacjenta), należy wykonać następujące czynności:

1 Wybrać kolejno opcje Tools > Options (Narzędzia > Opcje).
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2 Nacisnąć zakładkę Patient Lookup  (Wyszukiwanie pacjenta). Wyświetlone zostanie

następujące okno.

UWAGA: Za pomocą pól wyboru wybrać dane, które mają występować w tabeli Patient
Lookup (Wyszukiwanie pacjenta). Za pomocą strzałek w górę i w dół ustawić kolumny
w odpowiedniej kolejności.

Wybieranie danych do wyświetlenia

Za pomocą pól wyboru wybrać dane, które mają być wyświetlane, lub usunąć dane, które nie

mają być wyświetlane w tabeli Patient Lookup (Wyszukiwanie pacjenta).

Zmiana kolejności kolumn

Aby zmienić kolejność kolumn w tabeli Patient Lookup (Wyszukiwanie pacjenta), należy wybrać

kolumnę do przesunięcia i nacisnąć strzałki w górę lub w dół  (strzałki na górze i na dole

przesuwają kolumnę danych na samą górę lub na sam dół listy).

Kolumna danych na górze listy Column Display Order (Kolejność wyświetlania kolumn) jest

wyświetlana w pierwszej kolumnie tabeli Patient Lookup (Wyszukiwanie pacjenta). Kolumna

danych na dole jest wyświetlana w ostatniej kolumnie tabeli.

Kończenie ustawiania preferencji wyszukiwania pacjenta

Gdy na liście Column Display Order (Kolejność wyświetlania kolumn) występują wszystkie

pożądane dane w odpowiedniej kolejności, nacisnąć przycisk OK.

Tabela Patient Lookup (Wyszukiwanie pacjenta) zawiera teraz wszystkie wybrane dane i kolejność

kolumn.
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Preferencje na karcie Report Generation (Tworzenie raportu)

Tabela danych jest wyświetlana w oknie Select and Generate Reports (Wybieranie i tworzenie

raportów). Ta tabela jest używana podczas tworzenia raportów. Zawiera ona codzienne

informacje uzyskiwane z urządzeń pacjenta i, jeśli dotyczy to danego pacjenta, informacje z

jego konta oprogramowania CareLink Personal. Dane z tej tabeli pomagają określić, które dni

wymagają utworzenia raportu Daily Detail (Szczegóły z dnia). Pomagają one również podjąć

decyzję dotyczącą tego, jakie inne raporty należy utworzyć.

Dany zakład opieki zdrowotnej może dostosować dane wyświetlane w tej tabeli (łącznie z

kolejnością, w której są one przedstawiane), aby odzwierciedlić to, co ma największe znaczenie

w danym miejscu.

UWAGA: Informacje na temat sposobu, w jaki te preferencje odnoszą się do tabeli danych
podczas tworzenia raportu można znaleźć w części Wybór rodzajów raportów i dat do

przedstawienia w raporcie na stronie 43.

1 Wybrać kolejno opcje Tools > Options (Narzędzia > Opcje).

2 Nacisnąć zakładkę Report Generation  (Tworzenie raportu). Wyświetlone zostanie

następujące okno.

Wybieranie danych do wyświetlenia

Za pomocą pól wyboru wybrać dane, które mają być wyświetlane lub usunąć dane, które nie mają

być wyświetlane w tabeli danych.

W tabeli danych można umieścić następujące informacje.
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Nazwa kolumny Definicja

№ of Meter Readings (Liczba odczytów glukometru) Liczba odczytów dla określonej daty, które zostały
zarejestrowane przez kontrolowane urządzenia.

Meter Readings Average (Średni odczyt glukometru) Wartość średnia odczytów stężenia glukozy
zarejestrowanych przez kontrolowane urządzenia.

Sensor Duration (Czas trwania pracy sensora)
Czas, w obrębie określonej daty, przez który były
rejestrowane dane z sensora. Wartości wynoszą: (brak),
0:05–24:00.

Sensor Average (Średnia sensora) Wartość średnia odczytów z sensora zarejestrowanych
w obrębie określonej daty.

Highest Reading (Najwyższy odczyt) Najwyższy odczyt stężenia glukozy (uzyskany z sensora
lub glukometru) dla określonej daty.

Lowest Reading (Najniższy odczyt) Najniższy odczyt stężenia glukozy (uzyskany z sensora
lub glukometru) dla określonej daty.

Avg AUC Below Target (Średni obszar pod krzywą
poniżej docelowego)

Avg Area Under the Curve (Średni obszar pod krzywą)
poniżej zakresu docelowego pacjenta.

Avg AUC Above Target (Średni obszar pod krzywą
powyżej docelowego)

Avg Area Under the Curve (Średni obszar pod krzywą)
powyżej zakresu docelowego pacjenta.

Total Carbs (Łączna ilość węglowodanów)

Suma wszystkich węglowodanów (zaokrąglona do
najbliższego grama lub najbliższego 0,1 wymiennika,
w zależności od używanej jednostki pomiarowej)
odnotowanych w ciągu dnia przez zdarzenia
kalkulatora Bolus Wizard lub znaczniki węglowodanów
na pompie lub monitorze Guardian.

Suspend Duration (Czas trwania zawieszenia)
Czas, w obrębie określonej daty, przez który pompa
była zawieszona. Wartości wynoszą: (brak danych),
0:01–24:00.

№ of Rewinds (Liczba przewinięć) Liczba zdarzeń przewinięcia w obrębie określonej daty.

№ of Primes (Fills) (Liczba wypełnień (napełnień)) Liczba zdarzeń wypełniania (napełniania)
odnotowanych w obrębie określonej daty.

Prime (Fill) Volume (U) (Objętość wypełnienia
(napełnienia) (jedn.))

Całkowita objętość insuliny użyta podczas zdarzeń
wypełniania (napełniania) w obrębie określonej daty.

Total Insulin (U) (Całkowita insulina, jedn.)
Całkowita objętość insuliny podana w obrębie
określonej daty, zgodnie z wartościami
zarejestrowanymi przez pompę.

Total Basal (U) (Całkowita podstawowa dawka insuliny,
jedn.)

Całkowita objętość podstawowej dawki insuliny
podana w obrębie określonej daty (całkowita podana
insulina minus suma wszystkich podanych bolusów).

Total Bolus (U) (Całkowity podany bolus, jedn.)
Całkowita objętość insuliny podana w postaci bolusów
w obrębie określonej daty, zgodnie z wartościami
zarejestrowanymi przez pompę.

Basal % (% podstawowej dawki insuliny)
Pokazuje stosunek (w całkowitych wartościach %)
podstawowej dawki insuliny do całkowitej dawki
insuliny.

Bolus % (% bolusa)
Pokazuje stosunek (w całkowitych wartościach %)
insuliny podanej w postaci bolusa do całkowitej dawki
insuliny.

№ of Boluses (Liczba bolusów) Liczba zdarzeń bolusa zarejestrowanych w obrębie
określonej daty.

Bolus Wizard Events (Zdarzenia kalkulatora Bolus
Wizard)

Całkowita liczba zdarzeń kalkulatora bolusa
zarejestrowanych w obrębie określonej daty.

Bolus Wizard Overrides (Ignorowanie kalkulatora Bolus
Wizard)

Liczba zdarzeń kalkulatora bolusa, w których ilość
podanej insuliny była inna niż zalecana.
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Nazwa kolumny Definicja

№ of Meal Boluses (Liczba bolusów posiłkowych)
Liczba zdarzeń kalkulatora bolusa z ilością
węglowodanów większą od zera, a zarejestrowanych w
obrębie określonej daty.

№ of Correction Boluses (Liczba bolusów korekcyjnych)
Liczba zdarzeń kalkulatora bolusa z ilością korekty
większą od zera, a zarejestrowanych w obrębie
określonej daty.

№ of Manual Boluses (Liczba bolusów ręcznych)
Liczba zdarzeń bolusa zarejestrowanych w obrębie
określonej daty, które nie były zdarzeniami kalkulatora
bolusa.

Zmiana kolejności kolumn

Aby zmienić kolejność kolumn w tabeli danych, należy wybrać kolumnę do przesunięcia i

nacisnąć strzałkę w górę lub w dół  (strzałki na górze i na dole przesuwają kolumnę danych

na samą górę lub na sam dół listy).

UWAGA: Elementy na liście Column Order (Kolejność kolumn) są wyświetlane w pierwszej
kolumnie tabeli danych. Elementy na dole są wyświetlane w ostatniej kolumnie tabeli
danych.

Kończenie ustawiania preferencji tworzenia raportu

Gdy na liście Column Order (Kolejność kolumn) występują wszystkie pożądane dane w

odpowiedniej kolejności, nacisnąć przycisk OK.

Tabela danych zawiera teraz wszystkie wybrane dane i kolejność kolumn.
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Obszar roboczy Profile (Profil)

Profil jest podobny do okładki karty medycznej. Zawiera on dane, takie jak nazwisko i data

urodzenia. Profil jest wymagany, zanim dane urządzenia zostaną zebrane i użyte do utworzenia

raportów z terapii.

Obszar roboczy Profile (Profil) umożliwia również utworzenie połączenia z kontem pacjenta w

programie CareLink Personal. Po utworzeniu połączenia można uzyskać dane pacjenta

przechowywane w programie CareLink Personal w dowolnej chwili — obecność pacjenta nie jest

konieczna.

Przed rozpoczęciem

Pożądane może być dostosowanie profilów pacjentów w taki sposób, aby zawierały one

wyłącznie ten rodzaj informacji, który ma być pobierany. Więcej informacji na ten temat można

znaleźć w części Preferencje profilów pacjenta na stronie 14.
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Podczas ustawiania połączenia z kontem pacjenta w programie CareLink Personal jest również

wymagana nazwa użytkownika i hasło. Pacjent musi być obecny w celu podania tych danych.

Dodawanie nowych profilów

Za każdym razem, gdy do systemu CareLink Pro dodawany jest pacjent, należy zacząć od

utworzenia profilu dla tego pacjenta.

1 Wybrać kolejno opcje File > New Patient  (Plik > Nowy pacjent) lub nacisnąć przycisk Add

Patient  (Dodaj pacjenta). 

Wyświetlony zostanie obszar roboczy Profile  (Profil).

UWAGA: Aby dodać lub zmienić pola w profilu pacjenta, należy wybrać opcję customize

fields (dostosuj pola). Patrz Preferencje profilów pacjenta na stronie 14.

2 Wypełnić pola w sekcji Patient Profile  (Profil pacjenta).

3 Nacisnąć przycisk SAVE  (Zapisz).

Nowy pacjent został dodany do bazy danych oprogramowania CareLink Pro. Wyświetlany jest

komunikat potwierdzający zapisanie profilu.

Wypełnianie pól wymaganych

1 Jeżeli pole wymagane nie jest wypełnione w momencie zapisywania profilu pacjenta, obok

tego pola jest wyświetlany komunikat. Nie będzie można zapisać profilu, dopóki w tym polu

nie zostanie dokonany wpis.

2 Wypełnić pole.

3 Nacisnąć przycisk SAVE  (Zapisz).

4 Po wyświetleniu komunikatu potwierdzającego nacisnąć przycisk OK.

Edycja profilów pacjentów

1 Upewnić się, że obszar roboczy Profile  (Profil) jest otwarty.

2 Nacisnąć przycisk EDIT (Edycja).

3 Edytować dane w sekcji Patient Profile  (Profil pacjenta) zgodnie z wymaganiami.

4 Nacisnąć przycisk SAVE  (Zapisz).

Wyświetlany jest komunikat potwierdzający zapisanie profilu.

Usuwanie danych pacjenta z systemu

1 Upewnić się, że obszar roboczy Profile  (Profil) jest otwarty.
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2 Sprawdzić, czy jest to pacjent, który ma zostać usunięty. Usunięcie profilu pacjenta usuwa

również wszystkie dane tego pacjenta z bazy danych oprogramowania CareLink Pro i nie

można tego cofnąć.

3 Nacisnąć opcję >> delete patient record  (usuń rekord pacjenta) nad sekcją synchronizacji

profilu.

Wyświetlany jest komunikat ostrzegający, że wszystkie dane pacjenta zostaną skasowane po

usunięciu rekordu.

4 Nacisnąć przycisk Yes  (Tak) w celu usunięcia rekordu pacjenta.

Tworzenie połączeń z kontami programu CareLink Personal

Jeśli pacjent wyrazi na to zgodę, można ustawić połączenie z jego kontem w programie CareLink

Personal. To narzędzie, oparte na technologii sieciowej, umożliwia pacjentom przesyłanie i

przechowywanie danych uzyskanych z urządzenia i uruchamianie różnych raportów z terapii.

Po połączeniu z kontem pacjenta w programie CareLink Personal można pobierać dane

urządzenia, które są tam przechowywane. Jest to idealny sposób na tworzenie raportów z terapii

CareLink Pro między wizytami u lekarza. Eliminuje to również potrzebę odczytywania danych z

urządzenia pacjenta podczas jego wizyt w gabinecie.

Jeżeli pacjent nie ma jeszcze konta w programie CareLink Personal, można wysłać do niego

wiadomość e-mail z zaproszeniem do jego założenia.

Tworzenie połączenia z istniejącym kontem

UWAGA: Pacjent musi być obecny w celu wykonania opisanych czynności.

1 Upewnić się, że komputer jest podłączony do Internetu.

2 Otworzyć obszar roboczy Profile  (Profil) pacjenta.

3 Upewnić się, że wszystkie pola wymagane w sekcji Patient Profile  (Profil pacjenta) są

wypełnione.

4 Nacisnąć opcję LINK TO EXISTING ACCOUNT (Połącz z istniejącym kontem).

Wyświetlany jest ekran Log In (Logowanie) programu CareLink Personal.

5 Pacjent powinien wykonać następujące czynności:

a. Wpisać swoją nazwę użytkownika (Username) i hasło (Password).

b. Nacisnąć przycisk Sign In (Zaloguj).

Wyświetlona zostanie strona Grant Access (Udziel dostępu) w oparciu o ustawienia językowe

i regionalne wybrane przez pacjenta podczas rejestracji.

6 Pacjent powinien wykonać następujące czynności:

a. Przeczytać część Terms of Use (Warunki użytkowania).

b. Nacisnąć pole wyboru obok napisu I agree to the Terms of Use above... (Akceptuję

warunki użytkowania opisane powyżej...).

c. Nacisnąć przycisk Grant Access (Udziel dostępu).
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d. Powiadomić o wyświetleniu strony z podziękowaniami Thank You  (Dziękujemy).

7 W razie potrzeby można wydrukować część Terms of Use (Warunki użytkowania) dla

pacjenta, naciskając przycisk Print (Drukuj). Uzyskano połączenie z kontem pacjenta w

programie CareLink Personal.

Wysyłanie wiadomości e-mail z zaproszeniem

Aby wysłać wiadomość e-mail z zaproszeniem dla pacjenta do utworzenia konta w programie

CareLink Personal, należy wykonać poniższe czynności:

1 Otworzyć obszar roboczy Profile  (Profil) pacjenta.

2 Upewnić się, że wszystkie pola wymagane w sekcji Patient Profile  (Profil pacjenta) są

wypełnione.

3 Nacisnąć przycisk SEND E-MAIL INVITATION TO PATIENT  (Wyślij zaproszenie e-mail do

pacjenta).

4 Upewnić się, że pola Patient Name (Nazwisko pacjenta), E-mail Address  (Adres e-mail) i

Language  (Język) są prawidłowo wypełnione.

5 Nacisnąć przycisk SEND (Wyślij).

W obszarze statusu profilu pacjenta wyświetlone zostanie potwierdzenie wysłania

wiadomości e-mail.

Pobieranie danych z konta z połączeniem

W przypadku połączenia z kontem pacjenta w programie CareLink Personal wszelkie nowe

dane z tego konta są automatycznie wysyłane przy każdym otwarciu profilu danego pacjenta

w oprogramowaniu CareLink Pro.

UWAGA: Aby upewnić się, że to nastąpi, należy wybrać kolejno opcje Tools > Options >
General (Narzędzia > Opcje > Ogólne) i sprawdzić, czy pole „Synchronize with CareLink
Personal” (Synchronizuj z CareLink Personal) jest zaznaczone.
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Aby uzyskać dane pacjenta z programu CareLink Personal w dowolnym momencie po otwarciu

profilu pacjenta, należy wykonać następujące czynności:

1 Upewnić się, że obszar roboczy Profile  (Profil) jest otwarty, a komputer jest podłączony do

Internetu.

2 Wybrać kolejno opcje Tools > Synchronize Patient Data  (Narzędzia > Synchronizuj dane

pacjenta).

Ikona synchronizacji  w zakładce pacjenta obraca się. Zatrzymanie się ikony oznacza

ukończenie procesu.

UWAGA: Jeżeli pacjent nie chce już udostępniać swoich danych z programu CareLink
Personal, wyświetlany jest informujący o tym komunikat.

3 Wszelkie dodatkowe dane pobrane z programu CareLink Personal będą widoczne na raporcie

pacjenta.

Usuwanie połączenia z kontem programu CareLink Personal z oprogramowania
CareLink Pro

Można usunąć połączenie z kontem programu CareLink Personal z oprogramowania CareLink

Pro. Ta opcja jest dostępna jedynie po utworzeniu połączenia z kontem pacjenta. Powoduje

ona przerwanie pobierania danych przez oprogramowanie CareLink Pro z konta pacjenta w

programie CareLink Personal. Nie ma ona wpływu na osobiste korzystanie z konta programu

CareLink Personal przez pacjenta.

1 Otworzyć rekord pacjenta i uzyskać dostęp do obszaru roboczego Profile  (Profil).

2 Nacisnąć przycisk UNLINK ACCOUNT (Usuń połączenie z kontem).

3 Nacisnąć przycisk Yes (Tak) w komunikacie z potwierdzeniem. Nie występuje już połączenie

pomiędzy profilem osobistym pacjenta a oprogramowaniem CareLink Pro.

Stan zmienia się na Not linked (Niepołączony) i wyświetlane są przyciski LINK TO EXISTING
ACCOUNT (Połącz z istniejącym kontem) oraz SEND E-MAIL INVITATION TO PATIENT
(Wyślij zaproszenie e-mail do pacjenta).
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4

Ustawienia sprzętowe

Aby odczytać dane bezpośrednio z urządzenia, należy mieć urządzenie pacjenta wraz z wszelkimi

kablami lub urządzeniami komunikacyjnymi niezbędnymi do przesłania danych do komputera.

Jeśli pacjent przesłał swoje dane z urządzenia do swojego konta w programie CareLink Personal,

można również uzyskać dane przez utworzenie połączenie z jego kontem. Informacje na temat

uzyskiwania połączenia z kontem pacjenta w programie CareLink Personal można znaleźć w

rozdziale Tworzenie połączeń z kontami programu CareLink Personal na stronie 22.

Podłączanie urządzeń

Ogólny sposób ustawiania urządzeń w celu uzyskania komunikacji z komputerem jest

przedstawiony na rysunku poglądowym. Na pozostałych ilustracjach przedstawiono konkretne

aspekty komunikacji z urządzeniami.

Szczegółowe informacje są podawane w instrukcjach wyświetlanych przez oprogramowanie

CareLink Pro podczas odczytywania urządzeń.
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Rysunek poglądowy ustawienia sprzętu

Na poniższym przykładzie pokazano, jak za pomocą urządzenia CareLink USB komputer

komunikuje się z pompą. Listę obsługiwanych urządzeń komunikacyjnych zawiera część

Obsługiwane urządzenia na stronie 2.

Przykłady połączeń za pomocą kabla szeregowego i USB:
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Opcjonalne urządzenie ComLink do użytku z pompą z serii Paradigm:

Opcjonalne urządzenie Com-Station do użytku z pompą Medtronic MiniMed 508:
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5

Obszar roboczy Devices (Urządzenia)

Informacje wymagane do odczytania urządzenia pacjenta, takie jak producent, model i numer

seryjny, są przechowywane w obszarze roboczym Devices (Urządzenia). Dlatego też nie trzeba ich

podawać za każdym razem, gdy dane są odczytywane z urządzenia.

Urządzenia w obszarze roboczym Devices (Urządzenia) są przechowywane na jednej z dwóch list

— Active Devices (Urządzenia aktywne) lub Inactive Devices (Urządzenia nieaktywne). Po dodaniu

urządzenie jest automatycznie umieszczane na liście Active Devices (Urządzenia aktywne). Dane

można odczytywać wyłącznie z urządzeń na liście Active Devices (Urządzenia aktywne). Będą to

prawdopodobnie urządzenia wykorzystywane aktualnie przez pacjenta.

Inne urządzenia należące do pacjenta, ale niebędące aktualnie w użyciu, można przechowywać

na liście Inactive Devices (Urządzenia nieaktywne). W ten sposób informacje są przechowywane w

pliku. Urządzenia te można uaktywnić w dowolnym momencie.
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Przed rozpoczęciem

Aby otworzyć obszar roboczy Devices (Urządzenia) dla pacjenta, pacjent musi posiadać profil

zapisany w systemie. Patrz Dodawanie nowych profilów na stronie 21.

Aby dodać urządzenie lub bezpośrednio odczytać z niego dane, urządzenie musi być

skomunikowane z komputerem. Więcej informacji na temat ustawiania komunikacji między

urządzeniami a komputerem można znaleźć w części Podłączanie urządzeń na stronie 25.

Dodawanie urządzenia

Można uzyskać dane z konta pacjenta w programie CareLink Personal dla urządzenia, które nie

zostało jeszcze dodane. Takie urządzenia zostaną automatycznie dodane, gdy dane zostaną

zsynchronizowane pomiędzy programem CareLink Personal a oprogramowaniem CareLink Pro.

UWAGA: Tylko jedna pompa może być aktywna na jednego pacjenta. Dodanie nowej pompy
spowoduje przeniesienie istniejącej pompy na listę nieaktywną.

Dodawanie pompy firmy Medtronic lub monitora Guardian

1 Upewnić się, że dodawane urządzenie jest ustawione do komunikacji z komputerem.

(Informacje na temat etapów połączenia można znaleźć w części Podłączanie urządzeń na

stronie 25).

2 Nacisnąć zakładkę pacjenta lub dwukrotnie nacisnąć jego nazwisko w tabeli Patient Lookup

(Wyszukiwanie pacjenta).

3 Nacisnąć przycisk Devices  (Urządzenia)  w celu przejścia do obszaru roboczego

Devices (Urządzenia) pacjenta.

4 Nacisnąć przycisk ADD DEVICE  (Dodaj urządzenie).

5 Wybrać opcję Medtronic Pump/Guardian (Pompa firmy Medtronic/monitor Guardian).

Zostanie wyświetlony kreator Add Medtronic Pump/Guardian  (Dodawanie pompy firmy

Medtronic/monitora Guardian).
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UWAGA: Model pompy jest wyświetlany z tyłu pompy lub na ekranie stanu pompy.

6 Wybrać przycisk opcji w celu określenia dodawanego urządzenia.

W przypadku wybrania opcji MiniMed 508 pump (Pompa MiniMed 508) należy przejść do

punktu 9.

7 Nacisnąć przycisk NEXT (Dalej). Zostanie wyświetlona strona Serial Number (Numer

seryjny).

UWAGA: W przypadku niewprowadzenia prawidłowego numeru seryjnego zostanie

wyświetlony komunikat o błędzie. Należy sprawdzić przykłady na tej stronie i upewnić
się, że wprowadzane są prawidłowe znaki podane z tyłu pompy. Jeżeli jest to konieczne,

należy ponownie wpisać sześć znaków.

8 Na podstawie przykładów podanych na tej stronie znaleźć sześcioznakowy numer seryjny na

dodawanym urządzeniu. (W celu uzyskania dodatkowej pomocy w zlokalizowaniu numeru

należy nacisnąć opcję >> learn more  (dowiedz się więcej)).  Wpisać sześć znaków w polu

Device Serial Number  (Numer seryjny urządzenia).

9 Nacisnąć przycisk NEXT (Dalej). Wyświetlona zostanie strona Communication Options
(Opcje komunikacji) podobna do przedstawionej poniżej.
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10 Nacisnąć menu rozwijane Choose Port  (Wybierz port), a następnie wybrać port, za pomocą

którego urządzenie ComLink, Paradigm Link®, CareLink USB lub Com-Station łączy się z

komputerem. W przypadku braku pewności co do wyboru portu należy wybrać opcję Auto
Detect (or USB) (Automatyczne wykrywanie lub USB).

11 Nacisnąć przycisk NEXT  (Dalej). Wyświetlona zostanie strona Test Connection (Sprawdzanie

połączenia) podobna do przedstawionej poniżej.

12 Postępować zgodnie z instrukcjami i nacisnąć przycisk TEST.

Wyświetlony zostanie komunikat informujący o tym, czy udało się nawiązać połączenie. Jeżeli

tak, należy przejść do następnego punktu.

UWAGA: W tym teście nie są odczytywane dane z pompy, ale jest sprawdzana

poprawna komunikacja między pompą a komputerem.

Jeżeli nie, należy upewnić się, że sprzęt między urządzeniem a komputerem jest prawidłowo

podłączony. Należy również nacisnąć przycisk BACK  (Wstecz) na stronach kreatora w celu

upewnienia się, że wprowadzone dane urządzenia są poprawne.

13 Nacisnąć przycisk DONE  (Gotowe).

Urządzenie zostało dodane do listy Active Devices (Urządzenia aktywne) pacjenta.

Dodawanie glukometru

1 Nacisnąć zakładkę pacjenta lub dwukrotnie nacisnąć jego nazwisko w tabeli Patient Lookup

(Wyszukiwanie pacjenta).

2 Upewnić się, że dodawany glukometr komunikuje się z komputerem. (Informacje na temat

etapów połączenia można znaleźć w części Podłączanie urządzeń na stronie 25).

3 Nacisnąć przycisk Devices  (Urządzenia) w celu przejścia do obszaru roboczego Devices

(Urządzenia) pacjenta.

4 Nacisnąć przycisk ADD DEVICE  (Dodaj urządzenie).
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5 Wybrać opcję Blood Glucose Meter (Glukometr). Wyświetlony zostanie kreator Add Blood
Glucose Meter  (Dodawanie glukometru).

6 Nacisnąć przycisk opcji w celu wybrania odpowiedniej marki glukometru.

7 Nacisnąć przycisk NEXT (Dalej). Wyświetlona zostanie strona Meter Model (Model

glukometru); strona ta różni się w zależności od producenta glukometru.

8 Nacisnąć odpowiedni model glukometru w celu jego dodania.

9 Nacisnąć przycisk NEXT (Dalej). Wyświetlona zostanie strona Communication Options

(Opcje komunikacji).
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UWAGA: Można wybierać jedynie spośród tych opcji, które obowiązują dla dodawanego
glukometru.

10 Nacisnąć menu rozwijane Choose Port  (Wybierz port), a następnie wybrać port, za pomocą

którego urządzenie ComLink, Paradigm Link lub CareLink USB łączy się z komputerem. W

przypadku braku pewności co do wyboru portu należy wybrać opcję Auto Detect (or USB)

(Automatyczne wykrywanie lub USB).

11 Nacisnąć przycisk NEXT  (Dalej). Wyświetlona zostanie strona Test Connection (Sprawdzanie

połączenia).

12 Postępować zgodnie z instrukcjami podanymi dla glukometru i nacisnąć przycisk TEST.

W przypadku dodawania glukometru Bayer CONTOUR® USB należy upewnić się, że

oprogramowanie Bayer GLUCOFACTS® zostało zamknięte. Sprawdzić zasobnik systemu

Windows (pokazany poniżej). Jeśli ikona GLUCOFACTS jest widoczna, nacisnąć ją prawym

przyciskiem myszy i wybrać przycisk Exit  (Zakończ).

Wyświetlony zostanie komunikat informujący o tym, czy udało się nawiązać połączenie. Jeżeli

tak, należy przejść do następnego punktu.

Jeżeli nie, należy upewnić się, że sprzęt między urządzeniem a komputerem jest prawidłowo

podłączony. Należy również nacisnąć przycisk BACK (Wstecz) w kreatorze w celu upewnienia

się, że wprowadzone dane są poprawne.

13 Nacisnąć przycisk DONE  (Gotowe).

Glukometr został dodany do listy Active Devices (Urządzenia aktywne) pacjenta.

Ustawianie urządzenia jako aktywne lub nieaktywne

Urządzenia pacjenta można przenosić pomiędzy listą Active Devices (Urządzenia aktywne) a listą

Inactive Devices (Urządzenia nieaktywne) zgodnie z potrzebami. Aby można było odczytać dane z

urządzenia, musi ono być aktywne.
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Na liście Active Devices (Urządzenia aktywne) można mieć tyle glukometrów, ile jest potrzebne,

ale tylko jedną pompę. Przed dodaniem nowej pompy należy upewnić się, że bieżąca pompa ma

zostać dezaktywowana.

Dezaktywacja urządzenia

1 Nacisnąć zakładkę pacjenta lub dwukrotnie nacisnąć jego nazwisko w tabeli Patient Lookup

(Wyszukiwanie pacjenta).

2 Nacisnąć przycisk Devices  (Urządzenia) w celu przejścia do obszaru roboczego Devices

(Urządzenia) pacjenta. Urządzenia mogą być podane pod równoważną nazwą urządzenia.

Patrz Obsługiwane urządzenia na stronie 2.

3 Nacisnąć opcję >> make this device inactive  (dezaktywuj to urządzenie) pod urządzeniem,

które ma zostać dezaktywowane. Urządzenie zostaje przeniesione na listę Inactive Devices
(Urządzenia nieaktywne).

Ponowna aktywacja urządzenia

1 Nacisnąć zakładkę pacjenta lub dwukrotnie nacisnąć jego nazwisko w tabeli Patient Lookup

(Wyszukiwanie pacjenta).

2 Nacisnąć przycisk Devices  (Urządzenia). Wyświetlony zostanie obszar roboczy Devices
(Urządzenia) pacjenta.

Urządzenia mogą być podane pod równoważną nazwą urządzenia. Patrz Obsługiwane

urządzenia na stronie 2.

3 Nacisnąć opcję >> activate this device  (aktywuj to urządzenie) pod urządzeniem, które ma

zostać aktywowane.

Urządzenie zostaje przeniesione na listę Active Devices  (Urządzenia aktywne).

Usuwanie urządzenia

W wyniku opisanych poniżej czynności urządzenie zostanie usunięte z obszaru roboczego

Devices (Urządzenia) i z systemu CareLink Pro:

1 Nacisnąć zakładkę pacjenta lub dwukrotnie nacisnąć jego nazwisko w tabeli Patient Lookup

(Wyszukiwanie pacjenta).

2 Nacisnąć przycisk Devices  (Urządzenia) w celu przejścia do obszaru roboczego Devices

(Urządzenia) pacjenta.

Urządzenia mogą być podane pod równoważną nazwą urządzenia. Patrz Obsługiwane

urządzenia na stronie 2.

3 Upewnić się, że urządzenie znajduje się na liście Inactive Devices  (Urządzenia nieaktywne).

Jeżeli tak nie jest, nacisnąć opcję >> Inactivate this device  (dezaktywuj to urządzenie) pod

jego bieżącą pozycją.

4 Nacisnąć opcję >> delete this device  (usuń to urządzenie) pod urządzeniem, które ma zostać

usunięte. Wyświetlony zostanie komunikat ostrzegający, że urządzenie i wszystkie jego dane

zostaną usunięte z rekordu pacjenta.
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5 Nacisnąć przycisk YES  (Tak) w celu usunięcia urządzenia.

Urządzenie i jego dane zostaną usunięte z obszaru roboczego Devices (Urządzenia)

i z systemu CareLink Pro. Dane z tego urządzenia nie będą już dostępne do użytku

w raportach.

Odczytywanie danych z urządzenia

Jednym ze sposobów pobrania danych z urządzenia jest połączenie się z istniejącym kontem

pacjenta w programie CareLink Personal. (Patrz Tworzenie połączeń z kontami programu CareLink

Personal na stronie 22). Inny sposób to odczytanie ich bezpośrednio z urządzenia pacjenta, tak jak

to opisano poniżej.

Dane z urządzenia pacjenta mogą zostać odczytane przez oprogramowanie CareLink Pro, jeżeli

urządzenie znajduje się na liście Active Devices (Urządzenia aktywne) i komunikuje się z

komputerem. Po pobraniu danych można ich użyć do utworzenia raportów pomagających w

oszacowaniu kontroli leczenia pacjenta. Krótki opis dostępnych raportów można znaleźć w części

Informacje o raportach na stronie 44.

Oprogramowanie CareLink Pro może pobierać z pompy insulinowej następujące dane:

• różne ustawienia pompy, takie jak tryb powiadamiania, głośność dźwięku i godzina;

• podane dawki podstawowe insuliny;

• zdarzenia bolusa i podane dawki;

• wpisy kalkulatora Bolus Wizard;

• ilości wypełnienia;

• okresy zawieszenia;

• odczyty sensora glukozy przez dany okres dla pomp wyposażonych w sensor.
 
System może również zbierać dane z monitora Guardian REAL-Time, takie jak:

• odczyty stężenia glukozy z sensora,

• wartości współczynnika sensora,

• współczynniki kalibracji sensora,

• znaczniki posiłków,

• wstrzyknięcia insuliny.
 
Ponadto podczas odczytywania urządzenia do systemu można pobrać różne informacje zapisane

w glukometrze.
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OSTRZEŻENIE: Należy anulować lub zakończyć wszystkie tymczasowe wlewy podstawowe
lub aktywne bolusy i wyczyścić wszelkie aktywne alarmy. Pompa zostanie zawieszona na

czas odczytu. Po zakończeniu odczytu należy upewnić się, że pompa wznowiła pracę.

PRZESTROGA: Podczas odczytu pompy nie należy korzystać z pilota pompy. Jeśli bateria

pompy jest niemal zupełnie rozładowana, pompa nie będzie przesyłać danych do
komputera. Jeżeli stan wskazuje na niski poziom mocy baterii, należy ją wymienić.

1 Nacisnąć zakładkę pacjenta lub dwukrotnie nacisnąć jego nazwisko w tabeli Patient Lookup

(Wyszukiwanie pacjenta).

2 Upewnić się, że urządzenie pacjenta komunikuje się z komputerem. (Patrz Podłączanie

urządzeń na stronie 25).

3 Nacisnąć przycisk Devices  (Urządzenia) w celu przejścia do obszaru roboczego Devices

(Urządzenia) pacjenta.

Urządzenia mogą być podane pod równoważną nazwą urządzenia. Patrz Obsługiwane

urządzenia na stronie 2.

4 Na liście Active Devices (Urządzenia aktywne) znaleźć urządzenie, z którego mają zostać

pobrane dane, i upewnić się, że dane w polu Choose port (Wybierz port) są poprawne.

W przypadku pomp nacisnąć menu rozwijane Amount of Data  (Ilość danych) i wybrać ilość

danych do odczytu przez oprogramowanie CareLink Pro.

5 Nacisnąć powiązany przycisk READ DEVICE (Odczytaj urządzenie).

6 Postępować zgodnie z instrukcjami dla danego urządzenia i nacisnąć przycisk OK.

7 W oprogramowaniu CareLink Pro wyświetlany jest pasek postępu pokazujący stopień

ukończenia odczytu urządzenia.

W przypadku naciśnięcia przycisku CANCEL (Anuluj) w trakcie odczytu urządzenia

wyświetlony zostanie komunikat ostrzegający, że anulowanie działania może doprowadzić do

utraty wszystkich danych odczytanych do tej pory. Aby ponownie uruchomić pobieranie,

należy nacisnąć przycisk READ DEVICE (Odczytaj urządzenie).

- Aby anulować, nacisnąć przycisk YES  (Tak).

- Aby kontynuować odczytywanie danych z urządzenia, nacisnąć przycisk NO (Nie).

Gdy system zakończy odczytywanie danych z urządzenia, wyświetlony zostanie komunikat

potwierdzający ukończenie odczytu.

8 Kliknąć przycisk OK.

- W przypadku pomp postępować zgodnie z instrukcjami dotyczącymi wyprowadzenia ich

z trybu zawieszenia.
 
Jeżeli oprogramowanie CareLink Pro nie może pobrać danych z urządzenia, więcej informacji

można znaleźć w części Rozwiązywanie problemów.
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6

Obszar roboczy Reports (Raporty)

W oprogramowaniu CareLink Pro można utworzyć różne raporty, które będą pomocne w lepszej

kontroli leczenia cukrzycy u pacjentów. Informacje zawarte w każdym raporcie są oparte na

danych pobieranych z urządzeń pacjenta i konta pacjenta w programie CareLink Personal.

Raporty mogą być tworzone na ekranie, wysyłane bezpośrednio do drukarki albo zapisywane jako

pliki TIFF lub PDF, które można dołączyć do elektronicznej dokumentacji medycznej (ang. EMR,

Electronic Medical Record). Za pomocą jednej czynności można utworzyć kilka rodzajów

raportów.

Dane wyświetlane na tych raportach są pobierane z urządzeń pacjenta, z konta pacjenta w

programie CareLink Personal lub z obu tych źródeł.

UWAGA: Więcej szczegółów dotyczących składników raportów, a także przykładowe raporty,
znajdują się w Podręczniku dotyczącym raportów. Dostęp do Podręcznika dotyczącego

raportów można uzyskać z poziomu oprogramowania CareLink Pro po wybraniu kolejno
opcji Help > View Report Reference Guide (PDF) (Pomoc > Wyświetl podręcznik dotyczący

raportów (PDF)) i wybraniu odpowiedniego języka.
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Przed rozpoczęciem

Jeżeli w raporcie ma zostać przedstawiony pewien okres, konieczne jest posiadanie danych z

urządzenia pacjenta z tego okresu. Może również zajść potrzeba podłączenia urządzenia pacjenta

do komputera w celu uzyskania bieżących danych przed utworzeniem raportów.

Przed utworzeniem raportu należy zapoznać się z punktem Verify Report Settings  (Sprawdź

ustawienia raportu). W tym punkcie można dokładnie ustawić raport w taki sposób, aby pobrane

zostały żądane dane pacjenta.

Tworzenie raportów

Poniższe punkty mają na celu pomoc w lepszym zrozumieniu dostępnych raportów i procesu, w

wyniku którego są one tworzone.

Po zapoznaniu się z procesem tworzenia raportów i gdy wiadomo, jakie raporty mają zostać

utworzone, można rozpocząć tworzenie raportów.

Otwieranie obszaru roboczego Reports (Raporty)

Nacisnąć zakładkę pacjenta lub przycisk Open Patient (Otwórz rekord pacjenta) , a następnie

nacisnąć dwukrotnie nazwisko pacjenta.

Wyświetlony zostanie obszar roboczy Reports  (Raporty).

UWAGA: Aby upewnić się, że posiadane są najnowsze dane urządzenia z konta pacjenta w
programie CareLink Personal, należy nacisnąć przycisk SYNC DATA (Synchronizacja danych).

Wybór okresu przedstawianego w raporcie

1 Aby zmienić okres przedstawiony w raporcie (raportach), nacisnąć menu rozwijane Duration

(Czas trwania) i wybrać okres. (Maksymalny czas trwania wynosi 12 tygodni).

2 Daty rozpoczęcia i zakończenia są ustawiane automatycznie, chyba że wybrana zostanie

opcja custom date range  (niestandardowy zakres dat).

UWAGA: W przypadku wybrania zakresu daty dłuższego niż dozwolony zostanie
wyświetlony komunikat o błędzie. Należy wówczas zmienić czas trwania lub daty.

Jeżeli żądany jest niestandardowy zakres dat, należy nacisnąć menu rozwijane From (Od) lub

Through  (Do) i wybrać żądany miesiąc, dzień lub rok.

Kalendarz danych

Obszar kalendarza danych obszaru roboczego Reports (Raporty) zawiera trzymiesięczne okno

podawanych informacji.
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Niebieskie paski przedstawiają dane urządzenia. Pomarańczowy pasek przedstawia wybrany okres

przedstawiany w raporcie. Jeżeli dane urządzenia i okres przedstawiony w raporcie zachodzą na

siebie, oznacza to, że dla części lub całości wyświetlanego okresu przedstawionego w raporcie

posiadane są dane.

Na obszarze kalendarza danych są początkowo wyświetlane dane z ostatnich trzech miesięcy. Aby

zobaczyć inne miesiące, należy nacisnąć przyciski strzałek  na jednym z końców

wyświetlanych miesięcy.

Wybieranie źródła danych do przedstawienia

1 Jeżeli pacjent korzysta z glukometru łączącego się z pompą, wybrać jedną z poniższych opcji

podawania danych glukometru w raporcie:

- In the pump  (W pompie): Zaletą tej opcji jest to, że dane należy odczytać wyłącznie z

pompy pacjenta, przy czym pompa dodaje do odczytów z glukometru informacje o

czasie wystąpienia, a odczyty są bezpośrednio powiązane z wykorzystywanymi

obliczeniami kalkulatora Bolus Wizard. Wadą jest to, że jeżeli występują trudności w

komunikacji pomiędzy pompą a połączonym glukometrem, odczyty z glukometru dla

tego okresu czasu mogą nie zostać podane. W przypadku pomp MiniMed Paradigm

przed modelem 522/722 również wszelkie odczyty glukometru z obliczeń kalkulatora

Bolus Wizard, które nie zostaną wykorzystane, nie są podawane.

- In the link meter(s)  (W połączonych glukometrach): Zaletą tej opcji jest podawanie w

raporcie wszystkich odczytów przechowywanych w połączonym glukometrze. Wadą jest

to, iż w celu skorelowania danych z glukometru i pompy należy upewnić się, że zegary

pompy i glukometru zostały ze sobą zsynchronizowane. Dane z pompy i połączonego

glukometru muszą być również odczytane oddzielnie.

2 Aby dodać dane z urządzenia do raportu, należy zaznaczyć pole wyboru obok

odpowiedniego urządzenia.

Nie można dodać urządzeń wykluczonych podczas wyboru dokonanego w punkcie 1. Aby to

zmienić, należy wybrać inną opcję połączonego glukometru.

3 Aby wykluczyć dane urządzenia z raportów, należy odznaczyć pole wyboru obok

odpowiedniego urządzenia.

Nie można zmienić znaczników wyboru związanych z opcją wybraną w punkcie 1. Aby je

zmienić, należy wybrać inną opcję połączonego glukometru.
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Sprawdzanie danych urządzenia

1 W obszarze kalendarza danych obszaru roboczego Reports (Raporty) należy sprawdzić, czy

pomarańczowy pasek przedstawiający okres zawarty w raporcie zachodzi na niebieskie paski

przedstawiające dane urządzenia.

2 Jeżeli paski zachodzą na siebie przez cały okres przedstawiany w raporcie (raportach), dane

dla raportu są dostępne. Można nacisnąć przycisk NEXT  (Dalej) i przejść do części

Sprawdzanie ustawień raportów na stronie 41.

3 Jeżeli paski nie nakładają się na siebie lub nakładają się w niewystarczającym stopniu, można

wykonać jedną z poniższych czynności:

- Zmienić okres przedstawiany w raporcie.

- Pobrać dodatkowe dane urządzenia.

Pobieranie dodatkowych danych urządzenia

1 Aby pobrać więcej danych z urządzenia, nacisnąć przycisk READ DEVICE  (Odczytaj

urządzenie) powiązany z danym urządzeniem.

Wyświetlony zostanie pasek odczytywania urządzenia.

OSTRZEŻENIE: Należy anulować lub zakończyć wszystkie tymczasowe wlewy
podstawowe lub aktywne bolusy i wyczyścić wszelkie aktywne alarmy. Pompa zostanie

zawieszona na czas odczytu. Po zakończeniu odczytu należy upewnić się, że pompa
wznowiła pracę.

PRZESTROGA: Podczas odczytu pompy nie należy korzystać z pilota pompy. Jeśli bateria
pompy jest niemal zupełnie rozładowana, pompa nie będzie przesyłać danych do
komputera. Jeżeli ekran stanu urządzenia wskazuje na niski poziom mocy baterii,

należy ją wymienić.

2 Sprawdzić, czy dane w polu Choose port (Wybierz port) są poprawne dla tego urządzenia.

Aby zmienić to ustawienie, należy nacisnąć menu rozwijane dla tego pola i wybrać inne

ustawienie.

3 Upewnić się, że urządzenie jest podłączone do komputera.

4 Jeżeli urządzenie jest pompą, można określić ilość danych do pobrania. Należy nacisnąć

menu rozwijane Amount of Data  (Ilość danych) i określić ilość.

UWAGA: W przypadku wybrania opcji All available data  (Wszystkie dostępne dane)

system pobierze wszystkie dane znajdujące się w pompie. W wyniku tego działania
wszystkie istniejące podwójne dane w systemie zostaną nadpisane.
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5 Nacisnąć przycisk READ DEVICE  (Odczytaj urządzenie). Należy dokładnie przeczytać

wyświetlany komunikat, ponieważ zawiera on precyzyjne instrukcje dotyczące odczytania

pompy.

6 Postępować zgodnie z instrukcjami i nacisnąć przycisk OK.

Wyświetlony zostanie pasek odczytywania urządzenia.

Można anulować odczytywanie w dowolnym momencie, naciskając przycisk CANCEL

(Anuluj).

Wyświetlony zostanie komunikat potwierdzający zakończenie odczytu.

7 Kliknąć przycisk OK.

Dane urządzenia będą teraz widoczne w ramach kalendarza danych.

8 Nacisnąć przycisk NEXT (Dalej) na górze obszaru roboczego Reports (Raporty).

Wyświetlony zostanie krok Verify Report Settings (Sprawdź ustawienia raportów). Pozwala to

upewnić się przed utworzeniem raportu (raportów), że ustawienia dla tego pacjenta są

poprawne.

Sprawdzanie ustawień raportów

1 Upewnić się, że ustawienia Glucose Target  (Docelowe stężenie glukozy) mają żądane

wartości. Należy wpisać odpowiednie wartości lub nacisnąć strzałki w górę lub w dół w

polach Low  (Niskie) i High (Wysokie) w celu zwiększenia lub zmniejszenia wartości.

UWAGA: Znaczniki odczytywania urządzenia (|| |) są wyświetlane na linii czasowej

pobudek i posiłków, a także na linii czasowej znaczników posiłków. Ponieważ niektóre
raporty są oparte na danych występujących o określonych porach posiłków, pobudki
lub snu, ważne jest, aby znaczniki zdarzeń kalkulatora Bolus Wizard pacjenta i

odczytów glukometru były odpowiednio pogrupowane.

2 Aby dodać okres posiłku, nacisnąć przycisk ADD MEAL  (Dodaj posiłek). Aby dokonać edycji

istniejącego okresu posiłku, należy nacisnąć dowolne miejsce na obszarze jednego z posiłków

na linii czasowej.

Zostanie uaktywniony edytor okresów posiłków znajdujący się pod linią czasową.

UWAGA: Można zdefiniować maksymalnie pięć okresów posiłków. Wartości domyślne to
Breakfast (Śniadanie), Lunch (Obiad) i Dinner (Kolacja).

3 Wprowadzić tekst lub nacisnąć strzałki w celu wybrania żądanych ustawień.

Jeżeli te ustawienia mają zostać użyte wyłącznie dla tego posiłku, należy odznaczyć pole

wyboru Use these parameters for all of this patient's meals (Użyj tych ustawień dla

wszystkich posiłków pacjenta).

- Meal Name (Nazwa posiłku): nazwa, która ma zostać przypisana do okresu posiłku.

- Meal Time Period  (Okres czasu posiłku): godziny, pomiędzy którymi spożywany jest

posiłek.
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- Pre-Meal BG Target (mg/dl or mmol/l) (Docelowe stężenie glukozy przed posiłkiem,

mg/dl lub mmol/l): dolna i górna granica docelowego zakresu stężenia glukozy pacjenta

przed posiłkiem.

- Pre-Meal Analysis Period  (Okres analizy przed posiłkiem): okres, przez który będzie

analizowana glukoza przed rozpoczęciem posiłku. Odczyty glukozy zebrane w tym czasie

są wykorzystywane do szczegółowej analizy w raporcie.

- Post-Meal BG Target (mg/dl or mmol/l) (Docelowe stężenie glukozy po posiłku, mg/dl

lub mmol/l): dolna i górna granica docelowego zakresu stężenia glukozy pacjenta po

posiłku.

- Post-Meal Analysis Period  (Okres analizy po posiłku): okres, przez który będzie

analizowana glukoza po posiłku. Odczyty glukozy zebrane w tym czasie są

wykorzystywane do szczegółowej analizy w raporcie.

Można zmienić długość istniejącego okresu posiłku lub pobudki i kładzenia się spać,

naciskając na uchwyt na początku lub na końcu i przeciągając go, a następnie

upuszczając w innym miejscu na linii czasowej.

UWAGA: Okresy posiłków nie mogą na siebie zachodzić, ale linie początkowe i końcowe
mogą ze sobą graniczyć. Okresy posiłków muszą mieć co najmniej 60 minut długości.

4 Aby użyć ustawień z tego posiłku do wszystkich innych posiłków pacjenta, należy upewnić

się, że pole wyboru obok opcji Use these parameters for all of this patient’s meals (Użyj

tych ustawień dla wszystkich posiłków pacjenta) jest zaznaczone.

5 Po zakończeniu tworzenia lub edycji okresu posiłku nacisnąć przycisk SAVE  (Zapisz).

6 Aby usunąć okres posiłku, nacisnąć przycisk DELETE MEAL  (Usuń posiłek). Po pytaniu o

potwierdzenie nacisnąć przycisk DELETE  (Usuń).

7 W oprogramowaniu CareLink Pro ustawienia te mogą zostać zapamiętane dla danego

pacjenta do następnego razu, gdy będzie dla niego tworzony raport. Aby zapisać ustawienia

dla tego pacjenta, nacisnąć przycisk SAVE SETTINGS (Zapisz ustawienia).

8 Nacisnąć przycisk NEXT (Dalej) na górze obszaru roboczego Reports (Raporty).

Jest to etap Select and Generate Reports (Wybieranie i tworzenie raportów) procesu. Jest w

nim podana lista rodzajów raportów, a także tabela danych pomagająca wybrać, czy włączyć,

czy wykluczyć pewne dni danych z raportów Daily Detail (Szczegóły z dnia).
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UWAGA: Aby zmienić wyświetlanie tabeli danych, należy nacisnąć opcję >> customize
columns (dostosuj kolumny). Patrz Preferencje na karcie Report Generation (Tworzenie

raportu) na stronie 17.

9 Aby wydrukować ekran, należy nacisnąć ikonę PRINT (Drukuj) .

Wybór rodzajów raportów i dat do przedstawienia w raporcie

1 Zaznaczyć pola wyboru obok raportów, które mają zostać włączone do zestawu raportów.

UWAGA: Pole wyboru raportu Dashboard/Episode Summary (Tablica/Podsumowanie
epizodów) nie będzie dostępne, jeśli dane sensora i pompy obejmują mniej niż pięć dni
w wybranym okresie lub jeśli dane w tym okresie pochodzą z monitora Guardian.

2 Jeżeli podczas tego okresu przedstawianego w raporcie dane zostały odczytane z pompy lub

monitora Guardian więcej niż raz, może istnieć wiele przeglądów danych z urządzenia:

a. Należy upewnić się, że pole wyboru obok opcji Device Settings Snapshot  (Przegląd

ustawień urządzenia) jest zaznaczone.

b. Nacisnąć rozwijaną strzałkę i wybrać datę i godzinę dla żądanych danych.

- Pump (Pompa): wybrać przegląd danych z pompy pacjenta.

- Guardian:  wybrać przegląd danych z monitora Guardian pacjenta.

Jeżeli jakieś pole jest zaciemnione, dla okresu przedstawianego w raporcie nie ma

dostępnych danych.

3 Przewinąć tabelę danych w celu przejrzenia dostępnych informacji raportu Daily Detail

(Szczegóły z dnia).

- Można sortować dane w każdej kolumnie. Naciśnięcie nagłówka kolumny spowoduje

posortowanie danych w kolejności rosnącej. Ponowne naciśnięcie nagłówka spowoduje

posortowanie danych w kolejności malejącej.

UWAGA: Jeżeli dla jakiejś daty nie ma żadnych danych, daty tej nie można wybrać.

4 Zaznaczyć pole wyboru w wierszach tabeli danych dla każdej daty, dla której ma zostać

utworzony raport Daily Detail (Szczegóły z dnia).

- Aby za pomocą jednego kliknięcia włączyć lub wykluczyć wszystkie daty raportów Daily

Detail (Szczegóły z dnia), należy zaznaczyć pole wyboru na górze kolumny pól wyboru

tabeli danych.

Tworzenie raportów

1 Po sprawdzeniu wyborów dotyczących tworzenia raportów nacisnąć przycisk GENERATE
REPORTS  (Utwórz raporty) na górze obszaru roboczego Reports  (Raporty).

Wyświetlona zostanie lista opcji.

2 Wybrać opcję podglądu, drukowania lub zapisania raportu (raportów).

W przypadku wybrania opcji Preview  (Podgląd) wyświetlone zostanie okno Preview
(Podgląd).

3 Za pomocą strzałek poruszać się po raportach wielostronicowych.
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4 Nacisnąć jeden z pozostałych przycisków na górze okna Preview  (Podgląd) w celu zapisania

lub wydrukowania raportu (raportów).

5 Aby zamknąć to okno, należy nacisnąć przycisk Close  (Zamknij)  w prawym górnym rogu

okna.

Informacje o raportach

W tym temacie znajduje się opis każdego raportu. Więcej szczegółów dotyczących składników

raportów, a także przykładowe raporty, znajdują się w Podręczniku dotyczącym raportów. Dostęp

do Podręcznika dotyczącego raportów można uzyskać z poziomu oprogramowania CareLink Pro:

1 Wybrać kolejno opcje Help > View Report Reference Guide (PDF) (Pomoc > Wyświetl

Podręcznik dotyczący raportów).

2 Wybrać język dla Podręcznika dotyczącego raportów.
 
Raporty oprogramowania CareLink Pro mają następujące wspólne elementy:

• Nagłówek raportu — nagłówek raportu zawiera informacje identyfikacyjne, takie jak nazwa

raportu, nazwisko pacjenta i źródło danych.

• Stężenie węglowodanów i glukozy we krwi — na wykresach i w tabelach jednostki

węglowodanów są wyświetlane kursywą, a stężenie glukozy we krwi jest wyświetlane

czcionką pogrubioną.

• Dane z weekendu — dni weekendu są wyświetlane czcionką pogrubioną, aby można je było

łatwo zidentyfikować.

• Legendy  — na dole każdego raportu pojawia się legenda symboli. Chociaż symbol może

pojawiać się w kilku raportach, legenda jest specyficzna dla każdego raportu.

Raport Dashboard/Episode Summary (Tablica/Podsumowanie epizodów)

Raport Dashboard/Episode Summary (Tablica/Podsumowanie epizodów) jest dwustronicowym

raportem, który ma za zadanie dostarczyć zbiorcze informacje o całościowej kontroli stężenia

glukozy u pacjenta w wybranym okresie czasu. Pierwsza strona raportu nosi nazwę Therapy

Management Dashboard (Tablica kontroli leczenia), a drugą stronę stanowi Episode Summary

(Podsumowanie epizodów). Poniżej przedstawiono opisy obu stron.

Therapy Management Dashboard (Tablica kontroli leczenia)

Raport Therapy Management Dashboard (Tablica kontroli leczenia) pozwala na uwidocznienie

całościowej kontroli stężenia glukozy o danej porze dnia. Strona Dashboard (Tablica) pokazuje na

wykresach dobowych nakładające się odczyty stężenia glukozy pochodzące z sensora oraz

informacje o podanej insulinie. Strona Dashboard (Tablica) pokazuje także dane pozyskane w

ciągu nocy oraz w okresach okołoposiłkowych w celu ułatwienia oceny kontroli stężenia glukozy

przed posiłkami oraz po nich. Na podstawie tych wykresów można wzrokowo rozpoznać główne
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wzorce kliniczne, takie jak hiperglikemia, hipoglikemia oraz zmienność w obrębie całościowego

obrazu kontroli stężenia glukozy. Strona Dashboard (Tablica) zawiera analizę statystyczną

wzorców hipo- i hiperglikemicznych powtarzających się o określonych porach dnia.

Dodatkowo strona Dashboard (Tablica) umożliwia skorelowanie kontroli stężenia glukozy o

określonej porze dnia z głównymi modyfikatorami terapii, takimi jak schemat wlewu

podstawowego, przyswajanie insuliny, wrażliwość na insulinę i przeliczniki węglowodanów.

Zmniejsza to potrzebę ręcznego szukania zależności między zdarzeniami w wielu raportach.

Strona Dashboard (Tablica) pokazuje także całościową statystykę użytkowania pompy i sensora.

Episode Summary (Podsumowanie epizodów)

Strona Episode Summary (Podsumowanie epizodów) dostarcza szczegółowych informacji o

epizodach hipo- i hiperglikemii. Pokazuje ona najbardziej krytyczne epizody oraz częstość

powiązanych istotnych zdarzeń w celu późniejszej analizy. Jeśli to możliwe, w raporcie

wymienione są powszechnie znane przyczyny hipo- i hiperglikemii oraz propozycje leczenia.

Strona Episode Summary (Podsumowanie epizodów) dostarcza także ogólnych informacji

dotyczących głównych sposobów zachowań i przestrzegania zaleceń związanych z użytkowaniem

pompy insulinowej, urządzenia do ciągłego monitorowania glukozy i glukometru. Informacje te

mogą nie być związane z epizodami.

Raport Adherence (Zachowanie)

W raporcie Adherence (Zachowanie) przedstawione są dane opisujące sposób wykorzystania

pomp insulinowych i sensorów, a także zachowanie pacjenta dotyczące terapii. Raport ten

odpowiada na pytanie: „Czy ilość danych była wystarczająca do dokładnego określenia, w jaki

sposób pacjent korzysta ze swojej pompy insulinowej i sensora, jeżeli były one stosowane?”.

Odpowiada on także na pytanie: „Czy pacjent stosuje się do instrukcji dotyczących terapii?”.

Raport ten wskazuje również, czy zachodzi potrzeba przeprowadzenia z pacjentem rozmowy na

temat sposobu kontroli leczenia cukrzycy przez pacjenta.

Raport Sensor and Meter Overview (Informacje ogólne na temat sensora i
glukometru)

Raport Sensor and Meter Overview (Informacje ogólne na temat sensora i glukometru)

przedstawia w postaci graficznej dzienne wartości stężenia glukozy i wartości średnich

pochodzące z sensora i glukometru pacjenta, łącznie z rozbiciem na godziny w trybie 

24-godzinnym i informacjami na temat tego, w jaki sposób odnoszą się one do posiłków i

wzorców snu pacjenta. Znajdują się w nim również statystyki odczytów stężenia glukozy u

pacjenta i wykorzystania przez niego insuliny.

Jeżeli dostępne są dane z sensora, podobna analiza danych z sensora jest tworzona jako pierwsza

strona tego raportu. Jeżeli dane z sensora nie są dostępne, jako pierwsza strona zostanie

utworzona strona analizy danych z glukometru.
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Ostatnia strona (strony) raportu przedstawia wartość stężeń z dnia na dzień i jakość kontroli

glikemicznej, węglowodanowej i insulinowej pacjenta. Każda strona pokazuje, w jaki sposób ta

kontrola różni się podczas każdego dnia w całym okresie przedstawionym w raporcie,

maksymalnie do 14 dni na stronę.

Raport Logbook (Dzienniczek)

Raport Logbook (Dzienniczek) przedstawia dane dotyczące stężenia glukozy z glukometru,

węglowodanów i insuliny dla każdego dnia w okresie przedstawionym w raporcie. Stanowi on

dzienniczek zdarzeń rejestrowanych co godzinę, a także dziennych wartości średnich i sum. Każda

strona zawiera do 14 dni. Jeżeli okres przedstawiony w raporcie przekracza 14 dni, tworzone są

dodatkowe strony.

Raport Device Settings Snapshot (Przegląd ustawień urządzenia)

W raporcie Device Settings Snapshot (Przegląd ustawień urządzenia) przedstawiony jest przegląd

ustawień pompy lub monitora Guardian REAL-Time pacjenta dla określonej daty i godziny. Może

on pomóc w zrozumieniu innych raportów lub po prostu udokumentować ustawienia

pacjenta.

Ustawienia pompy lub monitora są rejestrowane wyłącznie w czasie, gdy urządzenie jest

odczytywane. Jeżeli urządzenie nie było odczytywane w okresie przedstawionym w raporcie, nie

będą dostępne żadne ustawienia.

Raport Daily Detail (Szczegóły z dnia)

Raport Daily Detail (Szczegóły z dnia) przedstawia dane dotyczące stężenia glukozy, ilości

węglowodanów i wykorzystanie insuliny przez pacjenta w wybranym dniu. Dla każdego dnia

wybranego z tabeli danych tworzony jest oddzielny raport.

Raport Daily Detail (Szczegóły z dnia) umożliwia szczegółowy wgląd w każdy wybrany dzień.

Pozwala on również skupić się na konkretnym dniu w przypadku przeczucia, że w terapii pacjenta

nastąpiły interesujące wydarzenia.

Eksportowanie danych

Można eksportować dane urządzenia zebrane i przechowywane w oprogramowaniu CareLink Pro.

W ten sposób dostarczane są wszystkie dane z urządzenia pacjenta do użycia w statystykach lub

do tworzenia wyspecjalizowanych raportów lub tabel. Plik .csv można zaimportować do

programu Microsoft Excel lub pewnych klinicznych programów statystycznych, w których można

dalej przetwarzać dane.

Plik .csv zawiera dane, w których zarejestrowane są działania urządzenia. Są tam podane np. listy z

zapisami odczytów glukometru, wartościami odczytów z glukometru otrzymanymi przez pompę

lub zmianami w dawce podstawowej.
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UWAGA: Jest to zaawansowana funkcja wymagająca znajomości surowych danych
urządzenia. Wymaga ona również biegłości w posługiwaniu się oprogramowaniem, do

którego importowany jest plik .csv.

Aby skorzystać z funkcji eksportowania oprogramowania CareLink Pro, należy wykonać

następujące czynności:

1 Nacisnąć zakładkę pacjenta lub przycisk Open Patient (Otwórz rekord pacjenta) , a

następnie nacisnąć dwukrotnie nazwisko pacjenta.

2 Upewnić się, że wyświetlany jest obszar roboczy Reports  (Raporty).

3 Za pomocą pól Duration (Czas trwania) lub From/Through  (Od/do) ustawić daty i długość

raportu.

Maksymalny czas trwania, który można wybrać, to 12 tygodni.

4 Nacisnąć łącze export selected data  (eksportuj wybrane dane).

Wyświetlone zostanie okno dialogowe Export Data to CSV File  (Eksportuj dane do pliku

CSV).

5 Przejść do miejsca, w którym plik .csv ma być przechowywany na komputerze. Aby zmienić

nazwę pliku, wpisać ją w polu File name  (Nazwa pliku).

6 Nacisnąć przycisk SAVE  (Zapisz).

UWAGA: Więcej informacji na temat danych w plikach CSV można znaleźć w dodatku

na temat danych CSV.

Plik .csv zostanie zapisany na komputerze w wybranym miejscu. Będzie można go

zaimportować do dowolnego programu obsługującego ten rodzaj plików.
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7

Administracja systemem

Ważne jest, aby regularnie tworzyć kopię zapasową bazy danych oprogramowania CareLink Pro.

W bazie danych przechowywane są wszystkie dane systemowe zgromadzone w rekordach

pacjenta, łącznie z informacjami o profilu, danymi pobranymi z urządzenia i ustawieniami

raportów.

Ważne jest również posiadanie najnowszej wersji oprogramowania CareLink Pro. Zaktualizowane

wersje są dostępne okresowo i mogą zawierać ważne ulepszenia. Można wybrać pomiędzy

wyszukiwaniem aktualizacji a byciem powiadamianym, gdy są one dostępne.

Stosowanie aktualizacji oprogramowania

Co jakiś czas dostępne są aktualizacje oprogramowania CareLink Pro. Po wyświetleniu

powiadomienia o aktualizacji należy wykonać opisane poniżej czynności w celu pobrania

najnowszej wersji oprogramowania.

UWAGA: Przed zastosowaniem aktualizacji oprogramowania należy wykonać kopię
zapasową bazy danych. Patrz Tworzenie kopii zapasowej bazy danych na stronie 50.

1 Upewnić się, że na komputerze jest dostępne i aktywne połączenie z Internetem.

2 Gdy dla oprogramowania CareLink Pro dostępna jest aktualizacja, wyświetlony zostanie

komunikat o aktualizacji oprogramowania CareLink Pro. Pozwala to na pobranie

aktualizacji.

3 Nacisnąć przycisk DOWNLOAD  (Pobierz). (W przypadku naciśnięcia przycisku CANCEL

(Anuluj), powiadomienie o aktualizacji zostanie zamknięte. Można pobrać aktualizację w

późniejszym terminie).

Wyświetlone zostanie ostrzeżenie zawierające zalecenie utworzenia kopii zapasowej bazy

danych.

4 Nacisnąć przycisk YES  (Tak) w celu utworzenia kopii zapasowej bazy danych (opis tej

procedury znajduje się w części Tworzenie kopii zapasowej bazy danych na stronie 50).

Nacisnąć przycisk NO (Nie), jeżeli kopia zapasowa danych została już utworzona.
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Wyświetlany jest komunikat potwierdzający, że pobrana została nowa wersja

oprogramowania CareLink Pro.

5 Aby zacząć korzystać z najnowszej wersji oprogramowania CareLink Pro, nacisnąć przycisk

YES  (Tak) w celu zamknięcia i ponownego otwarcia aplikacji. Nacisnąć przycisk NO (Nie),

jeżeli użytkownik woli zaczekać przed ponownym uruchomieniem oprogramowania CareLink

Pro.

Wyłączanie automatycznych aktualizacji

Jeżeli użytkownik nie chce otrzymywać powiadomień o aktualizacjach oprogramowania

CareLink Pro, powinien wykonać następujące czynności:

1 Wybrać kolejno opcje Tools  > Options (Narzędzia > Opcje).

2 Nacisnąć zakładkę General (Ogólne).

3 W sekcji Communications (Komunikacja) usunąć zaznaczenie pola wyboru obok opcji

Automatically check for software updates  (Automatycznie wyszukuj aktualizacje

oprogramowania).

Ręczne wyszukiwanie aktualizacji

W dowolnym momencie można ręcznie wyszukać aktualizacje oprogramowania CareLink Pro.

UWAGA: Przed zastosowaniem aktualizacji oprogramowania należy wykonać kopię
zapasową bazy danych. Patrz Tworzenie kopii zapasowej bazy danych na stronie 50.

1 Upewnić się, że na komputerze jest dostępne i aktywne połączenie z Internetem.

2 Wybrać kolejno opcje Tools > Check for Software Updates  (Narzędzia > Szukaj aktualizacji

oprogramowania).

3 Jeżeli żadne aktualizacje nie są akurat dostępne, wyświetlony zostanie komunikat. Jeżeli

aktualizacja jest dostępna, zostanie wyświetlony komunikat o aktualizacji oprogramowania

CareLink Pro.

4 Wykonać procedurę opisaną w części Stosowanie aktualizacji oprogramowania na

stronie 48.

Tworzenie kopii zapasowej i przywracanie bazy danych

Dobrym pomysłem jest ustalenie regularnego rozkładu wykonywania kopii zapasowych bazy

danych. Pomaga to w utrzymaniu regularności tej czynności i zmniejsza ryzyko utraty danych.

W przypadku wykonywania kopii zapasowej lub przywracania bazy danych system wyświetla

komunikat ostrzegawczy, jeżeli na innych komputerach znajdują się aktywni użytkownicy

oprogramowania.
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Tworzenie kopii zapasowej bazy danych

Poniższe czynności umożliwiają utworzenie kopii zapasowej aktualnej bazy danych do

wybranego miejsca.

1 Upewnić się, że wszystkie rekordy pacjentów są zamknięte.

2 Wybrać kolejno opcje Tools > Backup Database  (Narzędzia > Utwórz kopię zapasową bazy

danych).

UWAGA: Kopię zapasową bazy danych można zapisać na dysku sieciowym lub na
przenośnym nośniku danych (np. płycie DVD, płycie CD lub dysku USB).

3 Przejść do miejsca, w którym plik kopii zapasowej ma zostać zapisany na komputerze. Jeżeli

nazwa pliku kopii zapasowej ma zostać zmieniona, należy wpisać ją w polu File name  (Nazwa

pliku).

4 Nacisnąć przycisk Save  (Zapisz). Podczas zapisywania bazy danych wyświetlany jest pasek

postępu.

Po zakończeniu zapisywania kopii zapasowej wyświetlony zostanie komunikat.

5 Nacisnąć przycisk OK w celu zamknięcia komunikatu.

Przywracanie bazy danych

Jeżeli do aktualnej bazy danych nie można uzyskać dostępu lub z niej korzystać, może

zaistnieć potrzeba jej zastąpienia. Im aktualniejsza kopia zapasowa, tym mniej danych zostanie

utraconych w przypadku zastąpienia bazy danych.

PRZESTROGA: W przypadku przywracania bazy danych z kopii zapasowej wszystkie nowe
dane utworzone w aktualnej bazie danych od momentu powstania wybranej kopii

zapasowej zostaną utracone.

Następujące czynności pozwalają na wybranie kopii zapasowej przeznaczonej do zastąpienia

aktualnej bazy danych.

1 Upewnić się, że wszystkie rekordy pacjentów są zamknięte.

2 Wybrać kolejno opcje Tools > Restore Database (Narzędzia > Przywróć bazę danych).

3 Wybrać plik kopii zapasowej, który ma zostać użyty do zastąpienia aktualnej bazy danych

(zazwyczaj najnowszy).

4 Nacisnąć przycisk Open  (Otwórz). Wyświetlany jest komunikat ostrzegawczy przypominający

o danych, które mogą zostać utracone w przypadku kontynuowania przywracania bazy

danych.

5 Nacisnąć przycisk OK,  aby kontynuować. Gdy baza danych jest przywracana, wyświetlany jest

pasek postępu.

Po zakończeniu przywracania bazy danych wyświetlony zostanie komunikat.

6 Nacisnąć przycisk OK w celu zamknięcia komunikatu.
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Gdy system jest niedostępny

W przypadku próby uruchomienia systemu w momencie, gdy inny użytkownik wykonuje operację

tworzenia kopii zapasowej lub przywracania, zostanie wyświetlony komunikat informujący o

niedostępności systemu. Do chwili zakończenia zadania system będzie niedostępny.

Wykonać jedną z poniższych czynności:

• Poczekać na zakończenie procesu i udostępnienie systemu.

• Nacisnąć przycisk CANCEL (Anuluj) w celu wyjścia i spróbować ponownie później.
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Rozwiązywanie problemów

Ten temat zawiera informacje mające na celu pomoc w rozwiązywaniu problemów, które mogą

wystąpić podczas korzystania z oprogramowania CareLink Pro. Zawiera on również instrukcje

dotyczące odinstalowywania oprogramowania CareLink Pro, jeśli zajdzie taka potrzeba.

Błędy związane z ogólnym korzystaniem z aplikacji

Jeżeli użytkownik spróbuje pobrać aktualizację oprogramowania przez Internet, może otrzymać

komunikat o niewystarczających do tego uprawnieniach. Do pobierania aktualizacji

oprogramowania CareLink Pro wymagane są uprawnienia administratora.

1 Należy zamknąć aplikację oprogramowania CareLink Pro i ponownie uruchomić komputer.

2 Na komputerze powinna zalogować się osoba z uprawnieniami administratora.

3 Należy postępować zgodnie z instrukcjami w części Stosowanie aktualizacji oprogramowania

na stronie 48.

Brak połączenia z bazą danych

Komunikat o błędzie mówiący o braku połączenia z bazą danych oznacza jedną z następujących

sytuacji:

• Baza danych została przeniesiona. Baza danych musi znajdować się w tym samym miejscu,

które zostało wybrane podczas instalacji oprogramowania CareLink Pro. Jeżeli została ona

przeniesiona, należy przemieścić ją z powrotem w miejsce wybrane podczas instalacji.

• Komputer użytkownika nie jest podłączony do dysku sieciowego, na którym znajduje się baza

danych. Jeżeli baza danych znajduje się na dysku sieciowym, w sieci mogą występować

problemy uniemożliwiające dostęp do dysku. Należy skontaktować się z działem obsługi

komputerów w danej placówce w celu uzyskania pomocy w ponownym podłączeniu dysku

sieciowego, na którym znajduje się baza.
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Zapomniano hasło placówki do oprogramowania CareLink Pro

Jeżeli nikt nie pamięta hasła używanego w zakładzie opieki zdrowotnej do logowania do

oprogramowania CareLink Pro, należy ponownie zainstalować oprogramowanie CareLink Pro i

utworzyć nową bazę danych. Po ponownym zainstalowaniu oprogramowania nie będzie można

uzyskać dostępu do informacji o pacjentach znajdujących się w poprzedniej bazie danych. Hasło

utworzone podczas nowej instalacji należy zachować, aby w przyszłości nie utracić danych.

Błędy odczytu urządzenia

Błąd Objaśnienie

The selected serial port could not be opened. Another
operation might be in progress on that port. Please
wait until the port is available, or select another port.
(Nie można było otworzyć wybranego portu
szeregowego. Inne działanie na tym porcie może być
w toku. Należy poczekać, aż port będzie dostępny, lub
wybrać inny port).

Należy sprawdzić, czy wybrany port COM nie jest
wykorzystywany przez inny program lub wybrać inny
port. Należy spróbować ponownie uruchomić
wykorzystywany komputer, a następnie ponownie
odczytać urządzenie. Sprzęt (taki jak kabel) podłączony
do portu lub sam port może być uszkodzony. Należy
podłączyć sprzęt do innego portu i spróbować
odczytać urządzenie ponownie w celu określenia
problemu.

Auto Detect could not find the device on any
available port. Please check the cable connection,
device battery & status and try again, or try specifying
a serial port. (Automatyczne wykrywanie nie znalazło
urządzenia w żadnym dostępnym porcie. Należy
sprawdzić podłączenie kabla, baterię i stan urządzenia
i spróbować ponownie, lub spróbować podać port
szeregowy).

Należy sprawdzić połączenie pomiędzy kablem a
komputerem, a następnie sprawdzić, czy stan baterii
urządzenia jest dobry. Jeżeli tak jest, należy spróbować
podać port szeregowy komputera, do którego
podłączony jest kabel, zamiast wybierać automatyczne
wykrywanie.

Device not found at selected serial port. Please check
the cable connection, device battery & status and try
again, try selecting a different port, or try to Auto
Detect the device. (Nie znaleziono urządzenia w
wybranym porcie szeregowym. Należy sprawdzić
podłączenie kabla, baterię i stan urządzenia i
spróbować ponownie, spróbować wybrać inny port
lub spróbować skorzystać z automatycznego
wykrywania).

Należy sprawdzić połączenie pomiędzy kablem a
komputerem, a następnie sprawdzić, czy stan baterii
urządzenia jest dobry. Jeżeli tak jest, należy spróbować
wybrać inny numer portu szeregowego komputera lub
wybrać opcję automatycznego wykrywania.

Unable to communicate with the device. Please ensure
you’ve attached and selected the correct device, check
the cable connection, device battery and status, and
try again. (Nie można skomunikować się z
urządzeniem. Należy upewnić się, że zostało
podłączone i wybrane prawidłowe urządzenie,
sprawdzić podłączenie kabla, baterię i stan urządzenia,
a następnie spróbować ponownie).

Należy sprawdzić wszystkie ustawienia wybrane dla
odczytywanego urządzenia, łącznie z nazwą
urządzenia, numerem seryjnym i rodzajem połączenia.
Należy również upewnić się, że urządzenie, kabel i
komputer są prawidłowo połączone. Należy sprawdzić,
czy stan baterii i alarmu urządzenia jest prawidłowy.
Następnie spróbować odczytu ponownie.

Unexpected response... retrying (n%) (Nieoczekiwana
odpowiedź... ponowna próba w toku).

Z urządzenia została odczytana nieoczekiwana wartość.
System będzie ponownie próbował nawiązać
komunikację do momentu anulowania lub udanego
nawiązania komunikacji.

The link device was found, but the device (<serial #>)
is not responding. Please verify the device’s serial
number, place the device closer to the link device to
minimize signal interference, check device battery and
status. (Urządzenie komunikacyjne zostało znalezione,
ale urządzenie (nr seryjny) nie odpowiada. Należy
sprawdzić numer seryjny urządzenia, umieścić
urządzenie bliżej urządzenia komunikacyjnego w celu
zmniejszenia zakłóceń, sprawdzić baterię i stan
urządzenia).

Należy sprawdzić, czy został wpisany prawidłowy
numer seryjny. Jeżeli nie, należy ponownie
wprowadzić prawidłowy numer seryjny. Jeżeli numer
seryjny jest prawidłowy, należy spróbować przesunąć
urządzenie bliżej urządzenia komunikacyjnego. Należy
odsunąć urządzenie i urządzenie komunikacyjne od
możliwego źródła zakłóceń (takiego jak inne
urządzenia radiowe). Należy sprawdzić stopień
naładowania baterii oraz, w przypadku przesyłania
danych z pompy insulinowej, sprawdzić stan
podawania pompy.
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Błąd Objaśnienie

This pump is delivering a temp basal. Please cancel
the temp basal or wait until it completes, and then try
again. (Pompa podaje tymczasową dawkę
podstawową. Należy anulować tymczasową dawkę
podstawową lub poczekać, dopóki nie zostanie ona
zakończona, a następnie spróbować ponownie).

Pompa, którą próbuje odczytać użytkownik, podaje
tymczasową dawkę podstawową. Należy poczekać, aż
tymczasowa dawka podstawowa zostanie zakończona,
lub anulować tymczasową dawkę podstawową i
wówczas odczytać pompę.

This device has active errors or alarms. Please clear
the alarms and try again. (W pompie zostały
uaktywnione alarmy lub wykryte błędy. Należy
skasować alarmy i spróbować ponownie).

W pompie zostały uaktywnione alarmy, które
uniemożliwiają jej odczyt. Należy przeczytać instrukcje
dotyczące alarmów w celu ich skasowania. Należy
skasować alarm i ponowić próbę odczytania pompy.

This pump is delivering a bolus. Please cancel the
bolus or wait until it completes, and then try again.
(Pompa podaje bolus. Należy anulować bolus lub
poczekać, dopóki nie zostanie on zakończony, a
następnie spróbować ponownie).

Pompa, którą próbuje odczytać użytkownik, podaje
bolus. Należy poczekać, aż bolus zostanie zakończony,
lub anulować bolus i wówczas odczytać pompę.

The device returned invalid entries; all data read will
be discarded. (Urządzenie zwróciło nieprawidłowe
wpisy; wszystkie odczytane dane zostaną odrzucone).

Należy skontaktować się z lokalnym przedstawicielem
(patrz Pomoc na stronie 2).

Błędy podczas tworzenia raportu

Wiele wpisów danych dla tej samej daty

Jeżeli wiele wpisów danych istnieje dla tego samego dnia i godziny dla tego samego urządzenia,

system traktuje to jak konflikt i nie może go rozwiązać. Raporty utworzone za pomocą tych

danych urządzenia ominą porcję danych, która się nakłada.

Można spróbować dostosować okres przedstawiany w raporcie w celu ominięcia nakładających

się danych. Można też usunąć urządzenie z systemu, a następnie dodać je z powrotem w celu

usunięcia poprzednich odczytów.

System zamierza zignorować dane

Jeżeli w urządzeniu został zmieniony czas, co spowodowało nakładanie się danych lub przerwy w

danych o długości trzech godzin lub więcej, system nie włączy tej porcji danych do tworzonych

raportów.

Błędy tworzenia kopii zapasowej i przywracania systemu

Nie można zablokować bazy danych

Oznacza to, że system jest wykorzystywany przez wielu użytkowników i inni użytkownicy są

zalogowani. System nie pozwoli na utworzenie kopii zapasowej bazy danych, gdy inni

użytkownicy wykonują potencjalnie zadania mogące mieć wpływ na bazę danych. Kopię

zapasową bazy danych będzie można wykonać, gdy wszyscy inni użytkownicy zakończą

korzystanie z oprogramowania CareLink Pro.

Nie można ukończyć tworzenia kopii zapasowej lub przywracania systemu

Inni użytkownicy nie mogą się zalogować i nie można zakończyć tworzenia kopii zapasowej lub

przywracania systemu. Należy skontaktować się z lokalnym przedstawicielem (patrz Pomoc na

stronie 2).
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Przywracanie bazy danych kończy się niepowodzeniem

Plik kopii zapasowej bazy danych, którego użytkownik próbuje użyć do przywrócenia systemu,

jest uszkodzony. Należy spróbować przywrócić system z innego pliku kopii zapasowej.

Odinstalowywanie oprogramowania

Jeżeli zajdzie potrzeba odinstalowania oprogramowania CareLink Pro, należy wykonać

następujące czynności:

1 Otworzyć Panel sterowania przez menu Start  systemu Windows.

2 Wybrać polecenie Dodaj lub usuń programy.  Wyświetlone zostanie okno Dodawanie lub

usuwanie programów.

3 Przewinąć do programu Medtronic CareLink Pro  i  nacisnąć go.

4 Kliknąć przycisk Usuń.  Wyświetlone zostanie okno kreatora Install Shield.

5 Nacisnąć przycisk Next  (Dalej). Wyświetlony zostanie komunikat z prośbą o potwierdzenie

chęci usunięcia aplikacji.

6 Nacisnąć Yes (Tak). Zostanie uruchomiony program odinstalowujący i usunie program oraz

wszystkie jego pliki z komputera. Gdy to nastąpi, na ekranie kreatora zostanie wyświetlony

komunikat potwierdzający odinstalowanie.

7 Nacisnąć przycisk Finish  (Koniec).
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Tabela symboli

W poniższej tabeli przedstawiono ikony i symbole używane na opakowaniach i urządzeniach:

Opis Ikona

Jedna sztuka na pojemnik/opakowanie (1X)

Dołączony dysk CD

Należy zapoznać się z instrukcją użytkowania

Data produkcji (rok)

Numer katalogowy

Conformité Européene (Zgodność z normami Unii
Europejskiej). Ten symbol oznacza, że urządzenie
spełnia wszystkie wymogi dyrektywy MDD 93/42/EEC.

CareLink Pro Podręcznik użytkownika   Tabela symboli 56



A

Dane CSV

Gdy użytkownik eksportuje dane z oprogramowania CareLink Pro, są one eksportowane do

pliku .csv. Plik ten można wówczas zaimportować do arkusza kalkulacyjnego, takiego jak

Microsoft Excel. Kompletną listę danych, które może zawierać plik CSV, można znaleźć w

definicjach kolumn w pliku CSV.

Plik CSV zawiera nazwę i identyfikator pacjenta oraz okres przedstawiony w raporcie, a także

identyfikuje każde urządzenie objęte raportem.

Definicje kolumny danych

Nagłówek kolumny Definicja

Index (Indeks) Kolejność, w której dane zostały zarejestrowane przez
urządzenie.

Date (Data) Data zarejestrowania danych przez urządzenie.

Time (Godzina) Godzina zarejestrowania danych.

New Device Time (Nowa godzina urządzenia) Nowa data i godzina, jeżeli zostały one zmienione w
urządzeniu.

BG Reading (mg/dL or mmol/L) (Odczyt stężenia
glukozy, mg/dl lub mmol/l)

Odczyt stężenia glukozy we krwi zarejestrowany przez
glukometr, monitor Guardian lub pompę. Jeżeli dane
pochodzą z pompy lub monitora Guardian, ta
kolumna odzwierciedla ręczne stężenie glukozy oraz
stężenie glukozy otrzymane z glukometru Link.

Linked BG Meter ID (Identyfikator połączonego
glukometru)

Numer seryjny glukometru wysyłającego określone
odczyty stężenia glukozy we krwi do urządzenia.

Basal Rate (U/h) (Szybkość dawki podstawowej, jedn./
godz.)

Aktywna prędkość podstawowego wlewu insuliny w
jednostkach na godzinę.

Temp Basal Amount (Ilość tymczasowej dawki
podstawowej)

Jeżeli pompa podawała tymczasową dawkę
podstawową, jest to ilość tymczasowej dawki
podstawowej.

Temp Basal Type (Rodzaj tymczasowej dawki
podstawowej)

Rodzaj regulacji tymczasowej dawki podstawowej
(prędkość insuliny lub procent dawki podstawowej).

Temp Basal Duration (m) (Czas trwania tymczasowej
dawki podstawowej, min)

Długość czasu w minutach dla podawania
tymczasowej dawki podstawowej insuliny (patrz opis
rodzaju powyżej).
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Nagłówek kolumny Definicja

Bolus Type (Rodzaj bolusa)

Rodzaj podawania insuliny w bolusie [Normal —
normalny, Square — przedłużony, Dual (normal part)
— złożony (część normalna) lub Dual (square part) —
złożony (część przedłużona)].

Bolus Volume Selected (U) (Wybrana objętość bolusa,
jedn.)

Ilość jednostek insuliny wybrana do podania podczas
podawania insuliny w bolusie.

Bolus Volume Delivered (U) (Podana objętość bolusa,
jedn.)

Faktycznie podana ilość jednostek insuliny podczas
podawania insuliny w bolusie.

Programmed Bolus Duration (h) (Zaprogramowany
czas trwania bolusa, godz.)

Czas trwania dla bolusa o przedłużonym działaniu lub
porcji o przedłużonym działaniu dla bolusa złożonego.

Prime Type (Rodzaj wypełniania)

Ręczny lub stały. Rodzaj ręczny jest wykorzystywany
bezpośrednio po przewijaniu w celu wypełnienia
drenów zestawu infuzyjnego przed ich
wprowadzeniem. Rodzaj stały jest wykorzystywany po
wprowadzeniu zestawu infuzyjnego do wypełnienia
miękkiej kaniuli insuliną po wyjęciu igły do
wprowadzania.

Prime Volume Delivered (U) (Podana objętość
wypełnienia, jedn.)

Ilość jednostek insuliny podana faktycznie do
wypełnienia.

Alarm Nazwa alarmu, który wystąpił.

Suspend (Zawieszenie) Określa stan zawieszenia pompy.

Rewind (Przewijanie) Data i godzina przewinięcia urządzenia.

BWZ Estimate (U) (Szacowana wartość w kalkulatorze
Bolus Wizard, jedn.)

Szacowana ilość insuliny w bolusie obliczona za
pomocą kalkulatora Bolus Wizard w pompie Paradigm.

BWZ Target High BG (mg/dL or mmol/L) (Górna
granica docelowego stężenia glukozy we krwi w
kalkulatorze Bolus Wizard, mg/dl lub mmol/l)

Ustawienie górnej granicy zakresu docelowego
stężenia glukozy we krwi używane przez funkcję
kalkulatora Bolus Wizard.

BWZ Target Low BG (mg/dL or mmol/L) (Dolna granica
docelowego stężenia glukozy we krwi w kalkulatorze
Bolus Wizard, mg/dl lub mmol/l)

Ustawienie dolnej granicy zakresu docelowego
stężenia glukozy we krwi używane przez funkcję
kalkulatora Bolus Wizard.

BWZ Carb Ratio (Przelicznik węglowodanów w
kalkulatorze Bolus Wizard)

Ustawienie dla stosunku insuliny do węglowodanów.
Jeżeli jako jednostki wykorzystywane są gramy,
stosunek jest ilością gramów, na którą przypada
jednostka insuliny. Jeżeli jako jednostki
wykorzystywane są wymienniki, stosunek jest ilością
jednostek insuliny używanych do skompensowania
jednego wymiennika.

BWZ Insulin Sensitivity (Wrażliwość na insulinę w
kalkulatorze Bolus Wizard)

Ustawienie wrażliwości na insulinę. Wrażliwość na
insulinę określa, o ile poziom glukozy we krwi obniża
się w wyniku podania jednej jednostki insuliny. Jest to
ustawiane używane przez funkcję kalkulatora Bolus
Wizard.

BWZ Carb Input (Dane wejściowe ilości
węglowodanów w kalkulatorze Bolus Wizard)

Ilość węglowodanów wprowadzona do kalkulatora
Bolus Wizard i używana do oszacowania bolusa.

BWZ BG Input (mg/dL or mmol/L) (Dane wejściowe
stężenia glukozy w kalkulatorze Bolus Wizard, mg/dl
lub mmol/l)

Odczyt stężenia glukozy we krwi wprowadzony do
kalkulatora Bolus Wizard i używany do oszacowania
bolusa.

BWZ Correction Estimate (U) (Szacowana korekta w
kalkulatorze Bolus Wizard, jedn.)

Liczba jednostek insuliny w bolusie wymagana do
korekty stężenia glukozy we krwi, obliczona przez
funkcję kalkulatora Bolus Wizard.

BWZ Food Estimate (U) (Szacowana ilość przed
posiłkiem w kalkulatorze Bolus Wizard, jedn.)

Szacowana liczba jednostek insuliny w bolusie
wymagana do skompensowania oczekiwanego
spożycia ilości węglowodanów, obliczona przez
funkcję kalkulatora Bolus Wizard.
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Nagłówek kolumny Definicja

BWZ Active Insulin (U) (Aktywna insulina w
kalkulatorze Bolus Wizard, jedn.)

Obliczona ilość aktywnej insuliny pozostała w ciele z
poprzednio podanych dawek insuliny, występująca
podczas określania szacowanej ilości bolusa za
pomocą funkcji kalkulatora Bolus Wizard.

Sensor Calibration BG (mg/dL or mmol/L) (Stężenie
glukozy we krwi do kalibracji sensora, mg/dl lub
mmol/l)

Wartość stężenia glukozy wykorzystywana do kalibracji
sensora, podawana w mg/dl lub mmol/l.

Sensor Glucose (mg/dL or mmol/L) (Stężenie glukozy z
sensora, mg/dl lub mmol/l) Wartość stężenia glukozy zmierzonego przez sensor.

ISIG value (Wartość ISIG) Sygnały wejściowe odczytywane z sensora, mierzone
w nanoamperach (nA).

Więcej informacji o plikach CSV eksportowanych przez
oprogramowanie CareLink Pro

Tytuł na górze pliku CSV zawiera następujące informacje:

• nazwisko pacjenta,

• listę wybranych urządzeń i ich numery seryjne,

• wybrany zakres danych.
 
Każdy blok kolumn ma tytuł zawierający następujące informacje:

• nazwę urządzenia, do którego odnosi się blok danych;

• numer seryjny tego urządzenia.

Jeżeli dane nie są wyświetlane zgodnie z oczekiwaniami

Szereg różnych czynników może spowodować wyświetlanie danych CSV w sposób inny od

oczekiwanego.

• Zmiany daty lub godziny w urządzeniu mogą zmienić sekwencję lub spowodować

wyświetlenie rekordów spoza wybranego zakresu dat.

• Jeżeli pomiędzy odczytami z urządzenia występuje duża przerwa, dane dla tego urządzenia

mogą być wyświetlane w wielu blokach.
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Słownik

A1C - Hemoglobina glikowana.

AUC (ang. Area Under the Curve, Obszar pod krzywą) - Wskazuje na ilość odchyleń w górę i w
dół, zgodnie z zaprogramowanymi wartościami. Dane odchyleń wskazują na częstotliwość
odchyleń w górę lub w dół. Obszar pod krzywą wskazuje na skalę zdarzeń przez pokazanie jak
bardzo poza zakresem lub przez jak długo.

Audio bolus - Pompę można zaprogramować w taki sposób, aby użytkownik słyszał sygnał
dźwiękowy po wybraniu ilości insuliny w bolusie (0,5 lub 1,0 jednostka) do podania. Jest to
pomocne w sytuacjach, gdy ciężko jest zobaczyć przyciski na pompie.

Bolus Dual Wave® (Złożony) - Kombinacja bolusa zwykłego, podawanego natychmiast, oraz
następującego po nim bolusa o przedłużonym działaniu. Część insuliny z bolusa o
przedłużonym działaniu jest podawana równomiernie w pewnym okresie.

Bolus ekspresowy - Metoda podawania dla dowolnego rodzaju bolusa za pomocą przycisku
ekspresowego na pompie.

Bolus korekcyjny - Ilość insuliny potrzebna do zredukowania wysokiego stężenia glukozy w celu
przywrócenia zakresu docelowego.

Bolus podawany przed posiłkiem - Dawka insuliny przyjmowana w celu skompensowania
oczekiwanego wzrostu stężenia glukozy we krwi po jedzeniu.

Bolus ręczny - Opcja dostępna w menu BOLUS, gdy aktywny jest kalkulator Bolus Wizard. Jedna z
metod zaprogramowania bolusa bez korzystania z funkcji kalkulatora Bolus Wizard.

Bolus Square Wave® (O przedłużonym działaniu) - Bolus podawany równomiernie w
wyznaczonym okresie (od 30 minut do 8 godzin).

CareLink® Personal - Usługa online umożliwiająca zarządzanie danymi dotyczącymi cukrzycy
przez Internet.

Część bolusa o przedłużonym działaniu (Pd) - Druga część bolusa złożonego. Część o
przedłużonym działaniu jest podawana równomiernie we wskazanym okresie, po podaniu
części NATYCHMIASTOWEJ.

Easy Bolus™ - Metoda podawania zwykłego bolusa, korzystając z przycisku Easy Bolus (Łatwy
bolus) na pompie.

Funkcja schematów - Rozszerzona funkcja pompy umożliwiająca zaprogramowanie opcjonalnych
wlewów podstawowych (Schemat A lub Schemat B) właściwych dla rodzajów aktywności lub
wzorców stężenia glukozy, które nie są częścią dnia codziennego, ale należą do stylu życia
pacjenta. Takimi rodzajami aktywności mogą być np. uprawianie sportu raz w tygodniu, zmiana
godzin snu podczas weekendu lub zmiany hormonalne podczas cyklu menstruacyjnego.

GLU - Skrót oznaczający stężenie glukozy we krwi.
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Glukometr - Urządzenie medyczne służące do określania przybliżonego stężenia glukozy we krwi.
Mała kropla krwi jest umieszczana na jednorazowym pasku testowym, który glukometr
odczytuje i wykorzystuje do obliczenia stężenia glukozy we krwi. Glukometr wyświetla
następnie stężenie w mg/dl lub mmol/l.

HbA1c - Hemoglobina glikowana.

Hiperglikemia - Podniesione stężenie glukozy we krwi, obserwowane w wyniku monitorowania
stężeń glukozy we krwi z występowaniem lub bez występowania części lub wszystkich z
następujących objawów: nudności, wymioty, zaburzenia widzenia, ból głowy, zaburzenia
pokarmowe, częste oddawanie dużych ilości moczu oraz letarg.

Hipoglikemia - Niskie stężenie glukozy we krwi, obserwowane w wyniku monitorowania stężeń
glukozy we krwi z występowaniem lub bez występowania części lub wszystkich z
następujących objawów: nadmierny głód, drgawki lub drżenie, pocenie się, wirowanie obrazu
przed oczyma, zawroty głowy, ból głowy, niewyraźna mowa, nagłe wahania nastroju lub
zmiany osobowości.

ID nadajn. - Numer seryjny aktualnie używanego nadajnika.

Insulina w bolusie - Dawka insuliny podana w celu skompensowania oczekiwanego wzrostu
stężenia glukozy we krwi (np. po posiłku lub przekąsce) lub w celu obniżenia wysokiego
stężenia do poziomu zakresu docelowego.

ISIG - Wartości sensora oznaczające, czy elektronika nadajnika w systemie wzmocnionym
sensorem działa poprawnie. Jeżeli wartość ISIG jest mniejsza niż 24,00 nA lub większa niż
29,00 nA, należy skontaktować się z działem pomocy. Konieczna może być wymiana nadajnika.

Jednostki węglowodanów - Wartość posiłku wprowadzana do kalkulatora Bolus Wizard.
Wprowadzana w gramach (węglowodanów) lub wymiennikach węglowodanowych.

Krok - Skonfigurowana ilość insuliny używana przy podawaniu łatwego bolusa.

Łącze
(1) Służy do włączania i konfigurowania opcji glukometru umożliwiającej pompie odbiór
odczytów stężenia glukozy we krwi z glukometru.
(2) W tym systemie określenie to odnosi się również do łączy hipertekstowych. Po naciśnięciu
na nie łącze hipertekstowe powoduje przejście do innego miejsca w systemie lub innej witryny
internetowej.

MAD% (Mean Absolute Difference %, średnia procentowa różnica bezwzględna) -
Przedstawia poziom dokładności w kalibracji sensora na odczyty z glukometru. Im mniejsza ta
liczba, tym większa dokładność kalibracji. Wartość MAD% jest obliczana przez wyznaczenie
różnic pomiędzy blisko występującymi parami odczytów z sensora i glukometru, podzielenie
każdej różnicy przez odczyt z glukometru, a następnie uśrednienie wyników dla wszystkich par.

Maksymalna dawka podstawowa insuliny - Maksymalna dawka insuliny, jaką pompa może
podać jednorazowo w ramach wlewu podstawowego (określana przez użytkownika).

Maksymalny bolus - Maksymalna ilość insuliny w bolusie, jaką pompa może podać jednorazowo
(określana przez użytkownika).

Niskie GLU - Pompa uruchomi alarm, jeżeli sensor zasygnalizuje, że stężenie glukozy użytkownika
osiągnęło ustawioną wartość lub spadło poniżej. Istnieje możliwość włączania lub wyłączania
tej funkcji.

Opcja glukometru - Funkcja umożliwiająca pompie otrzymywanie odczytów stężenia glukozy we
krwi z połączonego glukometru.

Ostrzeżenie dot. zbiorniczka - Programowalne ostrzeżenie generujące powiadomienie, gdy w
zbiorniczku pompy pozostanie określona liczba jednostek lub gdy do opróżnienia zbiorniczka
pozostanie określony czas.

Profil wlewu podstawowego - Wlew podstawowy z godziną początku i końca. W celu osiągnięcia
lepszej kontroli glukozy użytkownik może zaprogramować w pompie kilka różnych profilów w
24-godzinnym okresie, przy czym każdy profil może mieć inny wlew podstawowy.

Przelicznik węglowodanów - Ilość węglowodanów kompensowana przez jednostkę insuliny.
(Patrz także stosunek wymienników).
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Przelicznik wymienników - Ilość insuliny potrzebna do skompensowania jednego (1) wymiennika
węglowodanowego. (Patrz także stosunek węglowodanów).

Przesyłanie - Proces przesyłania danych pompy lub glukometru na serwer oprogramowania
CareLink® Personal.

Przypomnienie o kalibracji - Pompa co 12 godzin uruchamia automatycznie powiadomienie
„GLKM GLU O GG:MM”, sygnalizując, że aktualna wartość kalibracji nie jest już poprawna.
Ustawiona wartość funkcji „Przyp.o kal.” jest przedziałem czasu przed wygaśnięciem ważności
aktualnej wartości kalibracji, kiedy to użytkownik chce otrzymywać przypomnienia o
konieczności dokonania kalibracji. Na przykład, jeśli wartość „Przyp.o kal.” została ustawiona na
2 godziny, powiadomienie „GLKM GLU O GG:MM” nastąpi 2 godziny przed momentem, w
którym wymagana będzie kalibracja.

RF - Częstotliwość radiowa (ang. RF, Radio Frequency).

Schemat standardowy - Zwykły wlew podstawowy, dostosowany do typowego trybu życia
pacjenta. Gdy funkcja schematów jest wyłączona, pompa działa zgodnie ze schematem
standardowym (wlewu podstawowego).

Schematy wlewu podstawowego - Użytkownik może zaprogramować w pompie do trzech
różnych schematów bazy do podawania podstawowej dawki insuliny: standardowy, A i B. Dla
każdego schematu istnieje możliwość ustawienia do 48 wlewów podstawowych.

Stężenie insuliny - Siła lub rodzaj insuliny, którą lekarz przepisał użytkownikowi. Ma ono wpływ
na prędkość podawania insuliny przez pompę. Jeżeli stężenie insuliny użytkownika ulegnie
zmianie, schematy wlewu podstawowego i maksymalną prędkość bolusa i dawki podstawowej
należy przeprogramować w pompie.

Test A1C - Test hemoglobiny A1C służący do interpretacji stężenia glukozy we krwi w danym
okresie.

Test HbA1c - Test hemoglobiny A1C służący do interpretacji kontroli stężenia glukozy we krwi w
okresie od 2 do 3 miesięcy.

Test ketonowy - Keton to produkt przemiany materii powstający, gdy organizm jest zmuszany do
spalania tłuszczu zamiast glukozy w celu uzyskania energii. Może to oznaczać brak insuliny w
organizmie. Test ketonowy mierzy ilość ketonu skoncentrowanego we krwi lub moczu.

Tym. - Tymczasowy.

Tymczasowy wlew podstawowy - Tymczasowy jednorazowy wlew podstawowy insuliny o
sprecyzowanej dawce i czasie trwania. Zaspokaja zapotrzebowanie na insulinę związane ze
szczególnymi rodzajami aktywności i stanami nienależącymi do typowego trybu życia pacjenta.

Urządzenie ComLink - Nadajnik-odbiornik o częstotliwości radiowej służący do pobierania
danych z pompy Paradigm do komputera.

Urządzenie Com-Station - Urządzenie służące do pobierania danych z pompy MiniMed 508 i
przesyłania danych z glukometrów innych producentów do komputera.

Wlew podstawowy - Ustawienie pompy zapewniające stały wlew insuliny w celu utrzymania
stabilnego stężenia glukozy we krwi między posiłkami i w nocy. Wlew podstawowy imituje
wytwarzanie insuliny przez trzustkę, zaspokajając niezwiązane z posiłkami zapotrzebowanie
organizmu na insulinę.

Wlew podstawowy insuliny - Godzinna, ciągła infuzja insuliny podawana automatycznie przez
pompę insulinową na podstawie zaprogramowanych profilów i spersonalizowanych prędkości
ustawionych w pompie. Pompa podaje dzienną infuzję insuliny, pokrywającą zazwyczaj
zapotrzebowanie na insulinę tła podczas okresów na czczo (tj. w nocy i pomiędzy posiłkami).

Wrażliwość na insulinę - Wartość w mg/dl (lub mmol/l), o jaką jedna jednostka insuliny obniża
stężenie glukozy we krwi. (Dane z kalkulatora Bolus Wizard).

Współczynnik bolusa korekcyjnego - Określa, o ile 1,0 jednostka insuliny obniży stężenie
glukozy we krwi. Ten współczynnik używany jest do obliczania wielkości bolusa korekcyjnego,
gdy stężenie cukru we krwi użytkownika jest wysokie. (Stężenie glukozy we krwi) – (docelowe
stężenie glukozy we krwi) = X. X ÷ (współczynnik bolusa korekcyjnego) = wielkość bolusa
korekcyjnego.

WW - Węglowodany
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Wysokie GLU - Pompa uruchomi alarm, jeżeli sensor zasygnalizuje, że stężenie glukozy
użytkownika osiągnęło ustawioną wartość lub ją przekroczyło. Istnieje możliwość włączania lub
wyłączania tej funkcji.

Zawieszenie - Funkcja przerywająca całkowicie podawanie insuliny. Powoduje anulowanie
podawanie bolusa i/lub wypełniania. Wlew podstawowy jest wstrzymywany do czasu
wznowienia.

Zestaw infuzyjny - Narzędzia używane do wkładania i mocowania kaniuli pod skórą i dostarczania
insuliny do miejsca wprowadzenia za pomocą rurek od pompy.

Zwykły bolus - Natychmiastowe podanie określonej liczby jednostek insuliny.
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